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1. Introduction 

This document provides instructions on deploying Altair Knowledge Studio and Knowledge 
Seeker products of version 2022.3 for all platforms and configurations. 

If you are upgrading from an older version, see Section 4: Release 2022.3 and Previous 
Versions. 

The Architecture White Paper is available upon request. 

2. Product Components (Overview) 

This guide covers deployment procedures for the desktop and server-based configurations of 
the following products: 

▪ Knowledge Studio 

▪ Knowledge Seeker 

▪ Knowledge Studio for Apache Spark 

Knowledge Studio and Knowledge Seeker include R and Python language integration 
features. If the intended users are going to use these features, R and Python software must 
be installed first. 

The product name and feature set activated for each product are defined by the license 
applied after the installation. 

2.1 Knowledge Studio and Knowledge Seeker 

The Standalone configuration of Knowledge Studio and Knowledge Seeker for 
Windows Desktop or Windows Server includes the following installation packages:  

▪ KS Workstation 

▪ KS Library for R 

▪ Altair Analytics Workbench (WPS Workbench) 

R and Python software are prerequisites. Installation instructions for the Standalone 
configuration are given in Section 7. 

The Client/Server configuration for Windows Server includes the following installation 
packages: 

Client side: 

▪ KS Workstation 

▪ Altair Analytics Workbench (WPS Workbench) 

Server side: 
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▪ KS Server 

▪ KS Library for R 

▪ Altair Analytics Workbench (WPS Workbench) 

The Client/Server configuration for Linux includes KS Workstation, KS Server, and 
Altair Analytics Workbench (WPS Workbench). KS Libraries for R and Python are built in 
the KS Server package. 

Prerequisite software: R and Python software must be installed on the server side if the 
end users require R or Python code integration features. 

The installation procedure for the client/server configuration is described in Section 8. 

2.3 Knowledge Studio for Apache Spark 

Knowledge Studio for Apache Spark™ is a data science platform integrated with Apache 
Spark technology to provide predictive analytics on large-scale distributed data structures 
- Hadoop HDFS, Amazon S3, and other storage types supported by Spark. 

For the prerequisites concerning the Apache Spark server and the storage cluster, see 
“Requirements for Knowledge Studio for Apache Spark” in Section 3.2. 

The Standalone configuration of Knowledge Studio for Apache Spark includes KS 
Workstation. For installation instructions, see Section 7. 

The Client/Server configuration for Windows or Linux includes the following 
installation packages: 

Client side: 

▪ KS Workstation 

Server side: 

▪ KS Server 

The installation procedure for the client/server configuration is described in Section 8. 
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3. Supported Hardware and Software Platforms 

3.1. Overview: Supported Operating Systems 

Altair Data Analytics products version 2022.3 are available in the standalone and 
client/server configurations for the following operating systems: 

KS Workstation 
(Standalone or Client) 

KS Server 

Windows on x86-64 platform 

• Windows 10 

• Windows 11 

• Windows Server 2016 

• Windows Server 2019 

• Windows Server 2022 

 

Windows Server on x86-64 platform: 

• Windows Server 2016 

• Windows Server 2019 

• Windows Server 2022 

Linux on x86-64 platform: 

• Red Hat Enterprise Linux 7 and 8  

• CentOS 7 and 8 

 

➢ All products are supported only on 64-bit systems. 

➢ Knowledge Studio for Apache Spark requires Apache Spark server. System 
requirements for this product are described at the end of Section 3.2 below.  

3.2. System Requirements 

• Microsoft .NET Framework 4.6.2 (or higher) and 3.5 Service Pack 1 are 
required for KS Workstation. The KS Workstation installation package includes 
the web installer for Microsoft .NET Framework 4.6.2 and installs it unless the 
same or a higher version is already present. It also enables Microsoft .NET 
Framework 3.5 if it is not already enabled in Windows features. 

• Microsoft Visual C++ 2015-2022 Redistributable package is required for KS 
Workstation and KS Server. Both KS Workstation and KS Server installers 
include the web installer for Microsoft Visual C++ 2015-2022 Redistributable and 
installs it unless the same or a higher version is already present. 

• KS Workstation includes KS PDF Printer component, which enables the Copy to 
PDF functionality for exporting decision trees, charts, and reports to PDF. The 
printer uses Amyuni PDF Converter by Amyuni Technologies, Inc. 

http://www.amyuni.com/
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The following are the minimum and recommended requirements for all configurations: 

1. Standalone Configuration 

KS Workstation 2022.3 – Standalone 

Minimum Recommended 

Windows 10 or 11 (64-bit) 

x86-64 CPU, 2 GHz 

4 GB RAM 

Disk space: 

• 4 GB for program files ** 

• 15+ GB for user’s projects 

Monitor resolution: 1152x864 

Windows 10 (64-bit) 

Quad-core x86-64 CPU, 2 GHz, or better 

8 GB RAM or more * 

Disk space:  

• 4 GB for program files **  

• 20+ GB for user’s projects 

Monitor resolution: 1680x1050 or better 

* The amount of RAM required for the Standalone configuration depends on the typical 
size of analytic datasets and the types of models to be built. If the users will be dealing 
with very large datasets and need help assessing the required amount of RAM, please 
email dasupport@altair.com. 
 
** If R and Python integration features are required, R and Python program files and 
packages may take additional 3 GB or more. 
 
 

2. Client/Server Configuration 

KS Workstation 2022.3 – Client 

Minimum Recommended 

Windows 10 or 11 (64-bit) 

x86-64 based CPU, 2 GHz 

4 GB RAM 

Disk space: 4 GB for program files 

Monitor resolution: 1152x864 

Windows 10 (64-bit) 

x86-64 based CPU, 2 GHz or higher 

8 GB RAM or more 

Disk space: 4 GB for program files  

Monitor resolution: 1680x1050 or better 

KS Server 2022.3 

mailto:dasupport@altair.com
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Minimum* Recommended 

Windows Server 2016, 2019, or 2022; Red Hat 
Enterprise Linux 7 or 8; CentOS 7 or 8 

x86-64 based CPU, 2 GHz 

8 GB RAM 

Disk space:  

• 3 GB for program files 

• 10+ GB per user for users’ projects 

Windows Server 2016, 2019, or 2022; Red 
Hat Enterprise Linux 7 or 8; CentOS 7 or 8. 

A multi-core x86-64 based CPU(s) with at 
least 8 cores in total, 2.5 GHz, or better ** 

16 GB RAM or more** 

Disk space:  

• 3 GB for program files 

• 15+ GB per user for users’ 
projects** 

 
 
** Note: System requirements for the server depend on the maximum number of users 
expected to be using KS Server concurrently. The KS Server performance also depends 
on the typical size of analytic datasets, on whether any other applications run on the same 
server, and other factors. To ensure that your product is compatible with your environment 
and delivers expected performance, please fill in the Installation Questionnaire. Contact 
your account representative or email dasupport@altair.com to request the questionnaire if 
necessary. 
 
If Python integration features are required, the prerequisite Python program files and 
packages may take at least 3 GB of disk space on the KS Server host, depending on the 
Python distribution of your choice. 

3. Requirements for Knowledge Studio for Apache Spark 

Knowledge Studio for Apache Spark is an application for data mining and predictive 
analytics on large-scale distributed data structures (HDFS, Amazon S3, Cassandra, etc.) 
via Apache Spark. 

The types of distributed storage supported by Knowledge Studio for Apache Spark are 
the same as those supported by Apache Spark. The product is supported for any Hadoop 
distribution satisfying the Apache Spark server requirements listed below. 

Examples of supported Hadoop distributions: 

• Cloudera CDH. All CDH versions compatible with Apache Spark 2.4: CDH 6.2 
and higher; See “CDS Powered By Apache Spark Requirements” 
https://www.cloudera.com/documentation/spark2/latest/topics/spark2_requiremen
ts.html. 
 

• Databricks Platform on Azure and AWS clouds with Apache Spark 2.4. See 
Apache Spark on Databricks. See also the Databricks documentation for Azure 
and AWS at https://databricks.com/documentation. 

mailto:dasupport@altair.com
https://spark.apache.org/
https://www.cloudera.com/documentation/spark2/latest/topics/spark2_requirements.html
https://www.cloudera.com/documentation/spark2/latest/topics/spark2_requirements.html
https://databricks.com/spark/getting-started-with-apache-spark
https://databricks.com/documentation
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Note: Spark cluster configurations with dynamic allocation are not supported. 

System requirements for the Knowledge Studio software components are described at 
the beginning of Section 3.2 (see above). The following are the requirements for Apache 
Spark Server. 

 

Apache Spark server requirements 

➢ Apache Spark version 2.4 

o Cluster management system options: Standalone (native Spark cluster) 
or Hadoop YARN or Apache Mesos 

➢ Python version 3.6 or higher, 64-bit (Python programming language) 

➢ The following Python packages: 

o Pandas:  the Python Data Analysis Library provides data structures and 
analysis tools for Python. 

o NumPy:  the package for scientific computing with Python 
o SciPy: the fundamental library for scientific computing (version 0.19.1 or 

higher) 
o Scikit-learn: tools for data mining and data analysis (version 0.19.0 or 

higher) 
o PyArrow: Python API of Apache Arrow (version 0.9.0 or higher) 

➢ Jupyter Notebook version 4 or higher 

➢ JupyterHub version 1.0 or higher 

 
For Jupyter Notebook prerequisites and installation instructions, see 
https://jupyter.readthedocs.io/en/latest/install.html 
 
For JupyterHub prerequisites and installation instructions, see 
http://jupyterhub.readthedocs.io/en/latest/ 
 
Note: The use of JupyterHub as a multi-user Jupyter notebook server is strongly 
recommended. If you prefer not to use JupyterHub, you can use basic authentication 
implemented by other mechanisms and configure them according to your security, 
authentication, and file system access requirements. 

Examples of supported types of distributed storage clusters:  

➢ Amazon EMR 

➢ Microsoft Azure HDInsight 

Note: The Apache Spark environment on Azure HDInsight has Jupyter but 
does not include JupyterHub by default. 

➢ Custom clusters satisfying the above requirements for Apache Spark, Python, and 
Jupyter Notebook. 

https://hadoop.apache.org/docs/current/hadoop-yarn/hadoop-yarn-site/YARN.html
http://mesos.apache.org/
https://www.python.org/
http://pandas.pydata.org/
http://www.numpy.org/
https://www.scipy.org/scipylib/index.html
http://scikit-learn.org/
https://arrow.apache.org/docs/python/
http://jupyter.readthedocs.io/en/latest/install.html
http://jupyterhub.readthedocs.io/en/latest/
https://jupyter.readthedocs.io/en/latest/install.html
http://jupyterhub.readthedocs.io/en/latest/
https://aws.amazon.com/emr
https://azure.microsoft.com/en-us/services/hdinsight/
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For your convenience, our Customer Support can provide a script for installing the 
necessary prerequisites, including the required Python packages. The script is provided 
upon request. You can modify it as you see fit to install the components that you need. 
Please contact Data Analytics Customer Support at dasupport@altair.com to request the 
script. 
 
For the client/server configuration of Knowledge Studio for Apache Spark, the range of 
TCP ports 6060 – 6090 on the server must be open for inbound connections from the client 
machines. In the standalone (desktop) configuration, Knowledge Studio for Apache Spark 
also uses ports in this range, but this is confined to localhost.  
 
For more information on the security configuration settings: 

• for KS Server on Windows, see Section 8.1.3: “Configuring KS Service”. 

• for KS Server on Linux, see subsection “Configuring Server Security (Network and 
Firewall Settings)” in Section 8.2.4: “Configuring KS Server on Linux” 

 
 
 
 

  

mailto:dasupport@altair.com
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4. Release 2022.3 and Previous Versions 

▪ Version 2022.3 can be installed and run side by side with any previous version. 

▪ Uninstalling Altair Data Analytics products does not remove the users’ data, project files, 
working directories or licenses. 

▪ If you run version 2022.3 side by side with 2022.2 or an older version for a period of 
evaluation or testing during the upgrade, use a separate working directory for each 
version, since older projects modified in version 2022.3 may no longer be compatible with 
their original version. See Section 5 for details about the Working Directory. 

▪ Project compatibility: 

o Altair projects created in versions 9.3 – 2022.2 can be opened and modified in 
version 2022.3 without any conversion. 

It is recommended to make a backup copy of your old projects before opening 
them in version 2022.3. 

o Forward compatibility is not supported: models and other objects in projects 
created or modified in version 2022.3 may not be loaded correctly when opened 
in 2022.2 or older versions. 

▪ KS PDF Printer compatibility: 

When using KS Workstation 2022.3 side by side with an older version, the error “Printer 
not activated, error code - 41” may occur when using the Copy to PDF command under 
the File menu. The solution is to reinstall both versions of KS PDF Printer by executing 
the following commands in Command Prompt started as administrator (here, version 
2021.1 is used as an example): 

  cd "C:\Program Files\Altair Data Analytics\KS Workstation 2022.3.0\bin" 

  Install -s -u "KS PDF Printer"  

  Install -s "KS PDF Printer"  

  cd "C:\Program Files\Altair Data Analytics\KS Workstation 2021.1.0\bin" 

  Install -s -u "KS PDF Printer"  

  Install -s "KS PDF Printer" 

o Note: In case KS PDF Printer is removed from the system, it can be restored 
by running AngossPDFInstall.cmd from C:\Program Files\Altair Data 

Analytics\KS Workstation 2022.3.0\bin. 
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5. Prerequisites 

This section describes installation prerequisites for all configurations and platforms. 

5.1.  Overview 

▪ Ensure that your systems meet the hardware and software requirements. Note that 
the required hardware resources (CPU, memory) depend on the typical size of 
analytic datasets, the type of data mining tasks to be performed by the users, the 
expected number of concurrent users in the case of a server-based configuration. 

▪ Knowledge Studio and Knowledge Seeker features include integration with Tableau® 
and Qlik® - business intelligence software for interactive data visualization. Tableau 
integration features in Knowledge Studio and Knowledge Seeker require Tableau 
Desktop or any Tableau workbook viewer on the user’s workstation and, optionally, 
web access to a Tableau Server from the user’s workstation. Tableau components 
can be installed independently of Altair Data Analytics products. Supported Tableau 
versions are 2019.1 and higher. Altair does not distribute Tableau software or 
licenses for it. If you do not use Tableau but would like to know more about it, please 
visit http://www.tableau.com/. 

▪ R and Python language integration features require R Software for statistical 
computing and Python software. Install them if the end users need these features. 
The instructions are given below in Sections 5.2 and 5.3. 

▪ For configurations with multi-user access (client/server or shared standalone 
software on a server): 

o For the client/server configuration, TCP port 5470 must be open on the 
KS Server host for inbound connections from the client machines. 
Knowledge Studio for Apache Spark also uses TCP port range 6060-
6090. See Section 8.1.4 for details. 

You may also need to add KS Server and KS Workstation to the list of 
authorized applications if such a list is maintained for your antivirus or other 
security systems. 

o Each user must have a user account recognized by the host machine where 
KS Server is installed. 

o For each user, a working directory with sufficient space must be allocated for 
their projects. For example, server administrators can create a directory 
KS_Projects with subdirectories KS_Projects/<user_name> for each 

user. A single shared directory may be used for all users, but it is a less 
organized way. 

The Working Directory does not have to be on the application server that 
hosts KS Server. It may be on a network drive, as long as it is on a file 
system accessible from the application server and the read & write access to 
this storage is fast enough. In the case of a Windows Server, users can 
specify a UNC path for the Working Directory. Note that KS Server cannot 
access mapped drives in the client/server mode on Windows. 

http://www.tableau.com/


 

13 
 © Copyright 2022. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

The necessary space to allocate can be calculated based on the average 
size of analytic datasets (number of rows and columns), the number of 
datasets in each project, and the number of projects. Assign the appropriate 
Read & Write permissions for the created directories as required by your 
security policies. Note: Any user can change their working directory at any 
time after the installation using the Connect or Set Working Directory 
commands in the File menu of KS Workstation. 

o If users will be importing data from databases, ODBC drivers for the source 
databases must be installed on the server, and the users must have 
sufficient permissions on the server to load the drivers. 

▪ Depending on the type of your license, prepare the following: 

o If you purchased your product with Altair Units License, you will receive 
either a license file and an installation guide for Altair License Manager or 
instructions to configure your machine for a Managed Altair Units license. 
See Section 14.2 for details. 

o If you were provided with a registration key, the end users should use it to 
activate the product after it has been installed. See Section 14.3 for details. 

5.2.  R Software for Statistical Computing 

Knowledge Studio and Knowledge Seeker support integration with the R language. R software 
must be installed as a prerequisite if the end users require the R integration feature. 

R versions 3.5.0 and higher are supported. Version 4.1.2 is the latest version of R that has 
been tested with Knowledge Studio and Knowledge Seeker 2022.3. 

Note: For the Client/Server configuration of Knowledge Studio and Knowledge Seeker, R is 
only required on the server side. 

5.2.1 R for Standalone and Client/Server Configuration on Windows 

R software is available at the R Project website http://www.r-project.org/.  

 

On the R Project page, click “download R” and select the preferred mirror site of the R 
Archive Network. On the next page click “Download R for Windows” 

https://www.r-project.org/
http://www.r-project.org/
https://cran.r-project.org/mirrors.html
https://cran.r-project.org/mirrors.html
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On the next page, click “Install R for the first time”: 

 

On the next page, click the download link to download the latest version of R software. If 
you need an older version of R, click on the “Previous releases” link on the same page. 

Run the downloaded R installation executable. In the third page of the installation wizard, 
make sure to select at least the Main Files and 64-bit Files components. 

 

Choose the remaining options as desired and finish the installation. 
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5.2.2. R for Client/Server Configuration on Linux 

To install R on Linux, use the following examples of R installation steps. 

On RHEL 7 and CentOS 7: 

sudo yum update 

sudo yum install epel-release 

sudo yum install R 

On RHEL 8 and CentOS 8: 

sudo dnf install epel-release 

sudo dnf config-manager --set-enabled powertools 

sudo yum install R 

The default R installation directory is /usr/lib64/R. To verify the installation, use the 

command  

R --version 

For more information on installing R on Linux, see the R project website https://www.r-
project.org/ and https://fedoraproject.org/wiki/EPEL  

5.2.3. Rserve Package for R   

The Rserve package (Binary R server) is required. It must be installed in the R library 
folder used by the R Code node in Knowledge Studio and Knowledge Seeker. By default, 
it is the common library location for R. On Windows, it is usually C:\Program 

Files\R\R-N.N.N\library, where N.N.N is the R version. On Linux, it is usually 

/usr/lib64/R/library. 

Make sure the common library location for R has Read and Write permissions for the 
intended user(s) or group. For example, for R version 4.0.3, it is C:/Program 

Files/R/R-4.0.3/library. For the client/server configuration, you may want to 

create a user group for KS Server users and assign the permission to the group. 

Windows:  

Run the R console and install the Rserve package into the common R library 
location. The following example assumes that the R version is 4.0.3:  

install.packages("Rserve", "C:/Program Files/R/R-4.0.3/library") 

Linux: 

• If you are using Amazon Linux AMI, install or update openssl-devel using the 
command yum install openssl-devel 

https://www.r-project.org/
https://www.r-project.org/
https://fedoraproject.org/wiki/EPEL
https://cran.r-project.org/web/packages/Rserve/index.html
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• Run R and install the Rserve package version 1.8-0 or higher. For example, to 
install Rserve from the repository https://rforge.net, use the following command 
from the R command line: 

install.packages("Rserve",,"https://rforge.net") 

The library location can be specified explicitly as follows: 

install.packages("Rserve","/usr/lib64/R/library","https://rforge.net") 

Refer to the R documentation for the install.packages and .libPaths commands, 

if necessary. 

5.3.  Python 

The Python Language Integration enables embedding Python programs into the visual 
workflows of Knowledge Studio and Knowledge Seeker projects. For more information on 
Python, see the Python project website https://www.python.org/.  

Prerequisites 

• The Python Code node feature requires Python version 3.7 or higher, Python Data 
Analysis Library (pandas), SciPy and NumPy libraries, and the reports package. 
Python 3.10 is the latest version of Python that has been tested with this feature. 

For the Client/Server configuration, Python is only required on the server side. On Linux, 
Python libraries should be installed for all users rather than in a local user directory. 

To enable Jupyter Notebook integration in the Client/Server configuration on Windows:  

• Set the following system environment variables on the server. Their values must be 
set to folders that have Read & Write permissions for all users of the application. 

o JUPYTER_CONFIG_DIR 

o JUPYTER_DATA_DIR 

o JUPYTER_RUNTIME_DIR 

• In the Windows Firewall on the server, open a range of TCP ports for Jupyter 
Notebook users (for example, 8800-8900) and inform each user of the port assigned 
to them for Jupyter Notebook use. 

5.4.  unixODBC and openssl for Linux 

The following prerequisites are required for KS Server on Linux: 

• unixODBC driver manager 

To install unixODBC, use the command 

    sudo yum install unixODBC 

https://rforge.net/
https://www.python.org/
https://www.python.org/
http://pandas.pydata.org/
https://www.scipy.org/
https://numpy.org/
https://pypi.org/project/reports/
http://www.unixodbc.org/
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To check the version of the installed unixODBC:  

    rpm -qa unixODBC 

• openssl and openssl-libs version 1.0.2 or higher 

To install the latest version, use the command 

    sudo yum install openssl openssl-libs 

6. Supported Installation Modes on Windows 

▪ To install an Altair Data Analytics product on a small number of workstations, run the 
downloaded MSI package on each workstation. This process is described below in the 
sections on deploying the standalone and client/server configurations. 

▪ To install the software in the silent mode from the command line without user interaction 
via the wizard, see Section 9.1, “Silent Install”. 

▪ The Altair Data Analytics software installer supports mass deployment on many 
workstations using automated installation tools. For example, macros can be specified in 
the installation wizard to customize the Working Directory location for individual users. 
See Section 9.2, “Customizations to Assist in Repackaging KS Workstation for 
Deployment”. 

▪ To deploy the product in a Citrix environment or use it with Remote Desktop Services, 
see Section 10. 
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7. Deploying the Standalone Configuration 

This section describes the process of installing the Standalone configuration of Altair Data 
Analytics products on Windows.  

▪ The Standalone configuration of Knowledge Studio and Knowledge Seeker for Windows 
Desktop or Windows Server includes KS Workstation and KS Library for R. For 
prerequisites related to R software, see Section 5.2.1. 

▪ The standalone configuration of Knowledge Studio for Apache Spark includes KS 
Workstation. For the Spark server requirements, see Section 3, Subsection: 
“Requirements for Knowledge Studio for Apache Spark”. 

7.1. Deploying KS Workstation (Standalone) 

1. Log in to the computer as a user with sufficient rights to install software. 

2. Double-click the downloaded MSI package KS-Workstation-2022.3-64bit.msi to start the 
installation. 

3. The installer prepares the InstallShield Wizard, and the Welcome window opens. Click 
Next >. 

 

4. The License Agreement window opens. If you accept the terms, select “I accept” and 
click Next >.  
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5. The Configuration Type window opens.  

▪ If the software will be used by a single user on this computer, select the option 
“Standalone (Desktop) configuration for a single user”.  

 

▪ If you are installing the software on this computer for multi-user access via 
Remote Desktop Connection, Citrix, or otherwise, select “Standalone 
configuration for multi-user access”. Click Next >. Skip to Step 8. 
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6. If you selected the option “Standalone (Desktop) configuration for a single user” at the 
previous step, select the appropriate option, depending on whether you are the intended 
user. Click Next >. 

 

7. If necessary, change the destination folder for the application program files by clicking the 
Change button and specifying the desired location. The default is C:\Program Files\Altair 
Data Analytics. Click Next >. 
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8. The License Directory window opens. Specify a folder that has Read & Write permissions 
for the intended user. If necessary, click Change and create a new folder. Click Next >.  

 

9. The Working Directory window opens. Enter a Working Directory for Altair project files 
that has Read and Write permissions for the intended user(s). If necessary, click Change 
and create a new folder. Note: The Working Directory can be changed after the 
installation at any time using the Set Working Directory command or the Connect 
command in the File menu. Click Next >.  
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10.  At the final step:  

▪ Choose whether to install the desktop shortcut. 

▪ The option to install KS PDF Printer is selected by default. It enables the function of 
saving decision trees, tables, charts and reports as PDF. Leave it selected unless 
you are already using a PDF printer driver or converter of the same brand. 

Click Install to start the installation. 
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11. The Setup Status window shows the installation progress. When the installation is 
complete, choose whether to launch the software now and click Finish. 

 

The installed software is now available in the Windows Start menu. Launch the application by 
double-clicking the desktop shortcut KS Workstation 2022.3.0 or selecting Start | All 
Programs | Altair Data Analytics | KS Workstation 2022.3. 

 

To activate the product, follow the instructions in Chapter 14: “License Administration”. 

 

NOTE: The KS Workstation installer enables Microsoft .NET Framework 3.5 if it is not 
already enabled in Windows features. If the installer fails to enable it, download the offline 
installer from the Microsoft website https://docs.microsoft.com/en-
us/dotnet/framework/install/dotnet-35-windows-10. 

7.2. Installing KS Library for R Integration 

Knowledge Studio and Knowledge Seeker support integration with R software environment for 
statistical computing. If the end users require this feature, install KS Library for R as described 
below. 

Prerequisites: R software and KS Workstation. In the Prerequisites section above, see 
Section 5.2: ”R Software for Statistical Computing”. The Rserve package is required (see 
Section 5.2.3: “Rserve Package for R”).  

1. Make sure R software and KS Workstation 2022.3 are installed. 

2. For R version 4.0.0 or higher, download KS Library 2022.3 for R 4.0 or higher from 
the Altair software download site. 

https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows-10
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows-10
https://www.r-project.org/
https://www.r-project.org/
https://cran.r-project.org/web/packages/Rserve/index.html
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For R version 3.5.0 - 3.6.3, download KS Library 2022.3 for R 3.5.0 - 3.6.3 from the 
Altair software download site.  

3. Uninstall any previous version of KS Library for R from the Programs and Features list 
in the Windows Control Panel. 

4. Double-click the downloaded installer file. Click Next > in the Welcome screen. 

 

5. In the License Agreement window, select “I accept” if you accept the terms. Click 
Next >. 
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6. The Destination Folder window opens. KS library for R will be installed into <R 

program folder>\R-X.X\library\, where R-X.X is the most recent version of R 

on the system, and <R program folder> is the R root folder (such as C:\Program 

Files\R). To change the destination folder to extract the temporary setup files 

needed to install the library, click the Change button. The default folder to extract the 
temporary setup files is C:\Program Files\Altair Data Analytics. 

 

Click Next >. 

7. Click Install. 
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8. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

As a result, three subfolders representing the required R integration libraries are created 
under <R program folder>\R-X.X\library\: 

• angoss 

• KnowledgeSurvival 

• xtable  

If you are going to use a different R library path, copy the folders angoss, xtable, and 

KnowledgeSurvival from <R program folder>\R-X.X\library\ to the desired R 

library location. 

Note: The Rserve package, whose installation was described in Section 5.2.3, must be 
present in the same R library location. 

7.3. Installing Altair Analytics Workbench (WPS Workbench) 

Knowledge Studio supports integration using SAS Language. This functionality is powered by 
Altair Analytics Workbench (formerly known as WPS Workbench). 

1. Download the 64-bit version of Altair Analytics Workbench from the AltairOne website. If 
you don’t have an account at AltairOne.com, please reach out to the person managing 
Altair software licenses at your organization. 

https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?tags=5f0e306ea536a11655834710&app=Altair+Analytics+Workbench&tab=Info
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2. Run the downloaded installation package. Click Next > in the Welcome screen.  

 

3. In the End-User License Agreement window, select “I accept the terms in the License 
Agreement” if you accept the terms. Click Next >. 

 

4. In the Custom Setup page, select all WPS program features, as shown below. To change 
the destination folder for the application program files, click the Change button and 
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specify the desired location. The default is C:\Program Files\World Programming\WPS 
Analytics\4\. Click Next >. 

 

5. Click Install to start the installation. 

 

6. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 
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7. When the installation has finished, the new folder WPS Analytics with the item WPS 
Workbench appears in the programs list of the Windows Start menu, and the WPS 
Workbench shortcut is created on the desktop. 

WPS Analytics uses the same license as Knowledge Studio. Activating Knowledge Studio 
with an Altair Units License automatically activates WPS Analytics on the same machine. 
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8. Deploying Client/Server Configuration 

The client/server configuration of Knowledge Studio and Knowledge Seeker includes KS 
Workstation and KS Server. KS Workstation must be installed on each client machine, and KS 
Server must be installed on the server. R Statistical Software, Python software, and KS Library 
2022.3 for R must be installed on the server if users need R and Python integration features. 

Note: If the users will be accessing KS Server on the server through a firewall and/or via VPN, 
TCP port 5470 must be open for inbound connections. KS Server and Workstation can be 
configured to use a different port if necessary. Additional ports need to be open for Knowledge 
Studio for Apache Spark. The details are provided in the sections below. 

Security protocols: In the client/server mode, TLS1.2 is used by default. If desired, you can 
configure KS Server to use TLS version 1.1 (see Section 8.1.2 “Configuring the KS Service for 
Windows” or Section 8.2.4 “Configuring KS Server on Linux”). The older versions TLS1.0, 
SSLv3, and SSLv2 are never used. 

Make sure all the installation prerequisites listed in Section 5 are met. Allocate the necessary 
disk space on the server and create Working Directories for the users following the guidelines 
in Section 5.  

Prior to installing KS Server on a machine that has a previous version of KS Server running, 
notify the users that they should exit the application to avoid the termination of their sessions, 
as the installer will shut down all KS server processes that may be running on the server at the 
time of installation. 

For deploying KS Server on Windows, follow the instructions in Section 8.1. For deploying KS 
Server on Linux, follow the instructions in Section 8.2. 

After installing KS Server, proceed to Section 8.3, which describes the process of deploying 
KS Workstation as part of the client/server configuration.  

Note: In the client/server configuration, both KS Workstation and KS Server must be of the 
same major version. For example, KS Workstation 2022.3 does not work with KS Server 
2021.3. When upgrading, you must upgrade the clients and the server to the new version. 

8.1. Deploying KS Server and Dependent Components on Windows Server 

This section describes the process of installing and configuring KS Server and dependent 
components on Windows Server platforms. 

8.1.1. Install KS Server on Windows 

1. Log in as an administrator to the machine that will host KS Server. 

2. It is assumed you have downloaded the KS Server package following the instructions 
in the email from the License Administrator. Double-click the downloaded MSI 
package KS-Server-2022.3-64bit.msi. 

3. The setup prepares the InstallShield Wizard, and the Welcome window opens. Click 
Next >. 

http://www.r-project.org/
https://www.anaconda.com/
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4. The License Agreement window opens. If you accept the terms, select ”I accept”. 

 

Click Next >. 

5. The Setup Type window opens: 

▪ To install all KS Server features with default settings, select the Express option. 
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o The application program files will be installed in the default location 
C:\Program Files\Altair Data Analytics.  

o A Windows Service called KSWinLoginService2022.3_64 will be installed 
and started automatically. 

 

Click Next > and then Install to start the installation. Proceed to Step 10 below. 

▪ To change the destination for KS Server program files or the KS service options 
such as the TCP port for the service to listen on, select the Custom option. 
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Click Next >. 

6. If you selected the Custom option, the Custom Setup window opens. To change the 
destination folder for the program, click the Change button and specify the desired 
location. The default is C:\Program Files\Altair Data Analytics. 

 

Click Next >. 

7. The License Folder window opens. Specify a folder that has Read and Write 
permissions for all intended users of KS Server. The default is C:\Program 

Files\Altair Data Analytics\License. 
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Click Next >. 

8. The Windows Service Setup window opens.  

The option Install and start KSWinLogin Service as Windows Service is selected 
by default. Leave it selected unless you are installing KS Server for Real-Time 
Scoring Web API only. If you deselect it, you will have to start KS Server manually 
from the command line, and it will not be restarted automatically if the server is 
rebooted. 

Specify the TCP port for the KSWinLogin service. The default is 5470. The port must 
be open for inbound connections on the server, as described in Section 8.1.4, 
“Configuring KS Service”. 

 

Click Next > and then Install to start the installation. 
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9. The Setup Status window opens. It shows the installation progress. When the 
installation is complete, click Finish. 

 

8.1.2. Install KS Library for R Integration on Windows Server 

Knowledge Studio and Knowledge Seeker support integration with R software 
environment for statistical computing. If the intended users are going to use this feature, 
install KS Library for R on the server as described below. 

https://www.r-project.org/
https://www.r-project.org/
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Prerequisites: R software and KS Server. R is only required on the server side. In the 
Prerequisites section above, see Subsection 5.2: ”R Software for Statistical Computing”. 

1. Make sure R software and KS Server 2022.3 are installed. 

2. For R version 4.0.0 or higher, download KS Library 2022.3 for R 4.0 or higher from the 
Altair software download site. 

For R version 3.5.0 - 3.6.3, download KS Library 2022.3 for R 3.5.0 – 3.6.3 from the 
Altair software download site.  

3. Uninstall any previous version of KS Library for R from the Programs and Features list 
in the Windows Control Panel 

4. Double-click the downloaded package for KS Library for R. Click Next > in the 
Welcome screen.  

 

5. In the License Agreement window, select “I accept” if you accept the terms and click 
Next >. 
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6. The Destination Folder window opens. KS library for R will be installed into <R 

program folder>\R-X.X\library\, where R-X.X is the most recent version of R 

installed on the system, and <R program folder> is R program files root folder (usually 
C:\Program Files\R). If necessary, change the destination folder to extract the 

temporary setup files needed to install the library by clicking the Change button. The 
default folder to extract the temporary setup files is C:\Program Files\Altair 

Data Analytics. 
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Click Next >. 

7. Click Install. 

 

8. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

As a result, three subfolders representing the required R integration libraries are created 
under <R program folder>\R-X.X\library\: 
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• angoss 

• KnowledgeSurvival 

• xtable 

If users are required to use a different R library path, copy the folders angoss, 

xtable, and KnowledgeSurvival to the desired R library location. 

Note: The Rserve package, whose installation was described in Section 5.2.3, must be 
present in the same R library location. 

8.1.3. Installing Altair Analytics Workbench (WPS Workbench) 

1. Download the 64-bit version of Altair Analytics Workbench from the AltairOne website. If 
you don’t have an account at AltairOne.com, please reach out to the person managing 
Altair software licenses at your organization. 

2. Run the downloaded installation package. Click Next > in the Welcome screen.  

 

3. In the End-User License Agreement window, select “I accept the terms in the License 
Agreement” if you accept the terms. Click Next >. 

https://cran.r-project.org/web/packages/Rserve/index.html
https://altairone.com/Marketplace?tags=5f0e306ea536a11655834710&app=Altair+Analytics+Workbench&tab=Info
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4. In the Custom Setup page, select all WPS program features, as shown below. To change 
the destination folder for the application program files, click the Change button and 
specify the desired location. The default is C:\Program Files\World Programming\WPS 
Analytics\4\. Click Next >. 

 

5. Click Install to start the installation. 
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6. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

7. When the installation has finished, the new folder WPS Analytics with the item WPS 
Workbench appears in the programs list of the Windows Start menu, and the WPS 
Workbench shortcut is created on the desktop. 

WPS Analytics uses the same license as Knowledge Studio Server. Activating KS Server 
with an Altair Units License automatically activates WPS Analytics on the same machine. 
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8.1.4. Configure KS Service (KSWinLogin Service) 

The Windows service KSWinLoginService2022.3_64 is installed and started 
automatically if you chose the default Windows Service Setup option in the KS Server 
installation wizard. 

The service is listening on the port that was specified in the wizard. The default is 5470. 
If you want to change the default port for KSWinLogin Service, specify the desired port 
number in the KS Server configuration file KSWinLogin.conf, whose default location is 
C:\Program Files\Altair Data Analytics\KS Server 2022.3.0\bin. 

For example, to change the default port to 5480, open the file KSWinLogin.conf in a text 
editor and add the following line: 

port 5480 

Then open Services from the Windows Control Panel | Administrative Tools and restart 
KSWinLoginService2022.3_64.  

Upon each client connection from KS Workstation, KS Server creates a process called 
KSWinLogin.exe. Server administrators can monitor these processes in the Task 
Manager. Connection attempts are logged in the Windows Server Event Viewer in the 
Application and Security logs in the Windows Logs folder.  

Cryptographic Protocols:  

TLS1.2 is used by default. If desired, you can configure KS Server to use TLS version 
1.1. In that case, add the following line in the KS service configuration file 
KSWinLogin.conf in C:\Program Files\Altair Data Analytics\KS Server 2022.3\bin: 

ssl_options tls1.1 

The older versions TLS1.0, SSLv3 and SSLv2 are never used. 

Windows Firewall configuration 

Create a new inbound rule for the KS Server TCP port.  

In your Windows Server Control Panel, open System and Security → Administrative 
Tools → Windows Firewall with Advanced Security 
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Expand the top item in the left panel and open Inbound Rules. In the Actions panel on 
the right, click New Rule… 

In the New Inbound Rule Wizard, select the Port option. 

 

At the next step, select the TCP option and choose “Specific local ports”. Then specify 
the port(s) to open for inbound connection from the client machines. Note: If you 
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configured KS Server to run on a non-default port, replace “5470” below with the port number you 
specified in KSWinLogin.conf. 

• For Knowledge Seeker or Knowledge Studio: 

o enter port number 5470 

o if users require the Jupyter Notebook integration feature, in addition to 
5470, specify the range of TCP ports to be used by Jupyter Notebook 
users (for example, 8800-8900) 

• For Knowledge Studio for Apache Spark, open port 5470 and the port range 
6060–6090. 

See the example screenshot below. 

 

At the next step, select the option “Allow the connection” or “Allow the connection if it is 
secure”, depending on your security requirements. 
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At the next step, select the desired profiles depending on your security requirements. At 
least the Domain profile is usually required. 

 

At the next step, enter the name for the new rule (for example, “Altair KS Server”) and 
optional description.  
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Click Finish. The new rule will be created in the Windows Firewall with Advanced 
Security configuration. 

 

8.1.5. Configure User Rights on the Server 

Create a user group that includes all intended users of KS Server in the client/server 
mode. For example, call it KS_Users. Note: Creating the group is optional. You may 
choose to add permissions to an existing user group that includes all potential KS 
Server users, or to individual users instead. 
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▪ Open the Local Security Policy or Local Security Settings item of the Server 
Administrative Tools. Open Local Policies and select User Rights Assignment. 

▪ Edit the following policies to add the KS user group or individual users: 

➢ Access this computer from the network  

➢ Either Allow Log on locally OR Log on as a batch job, depending on the 
security requirements in your network. 

 

▪ If you choose the option Log on as a batch job, update the KS Server 
configuration file KSWinLogin.conf. Its default location is C:\Program 

Files\Altair Data Analytics\KS Server 2022.3.0\bin. Open 

the file KSWinLogin.conf in a text editor and add the line 

logon_type batch 

▪ Restart the service KSWinLoginService2022.3_64 
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▪ If the product will be used with a Registration-Key license, make sure that the KS 
Server license folder has Read & Write permissions for all KS Server users. The 
default location is C:\Program Files\Altair Data Analytics\License.  

8.1.6. Configure WPS Analytics and SSH Server 

Configure WPS Analytics 

1. Create a new parent folder on the server for the WPS standard libraries 
SASUSER and WORK. The WORK library is for temporary WPS files. It is 
recommended to use the same drive where the Knowledge Studio users’ working 
directories are set up. For example, create a new folder called E:\WPS_HOME. 
This folder must have Read & Write permissions for all KS Server users.  

2. Edit the WPS configuration file wps.cfg located in the WPS root folder 
C:\Program Files\World Programming\WPS Analytics\<version_number>. 
Change the values of the SASUSER and WORK parameters in wps.cfg. For 
example, if the folder you created is E:\WPS_HOME, then specify:  

-SASUSER 'E:\WPS_HOME\!USERNAME\My WPS Files' 

-WORK 'E:\WPS_HOME\!USERNAME\TEMP' 

Save the changes in wps.cfg. 

Note: In case of any issues with user-specific subfolders, you may omit the 
!USERNAME variable referring to user-specific locations and define common 
SASUSER and WORK locations as follows (generally not recommended, as this 
is a less organized way): 

-SASUSER 'E:\WPS_HOME' 

-WORK 'E:\WPS_HOME\TEMP' 

3. Set the environment variables for the WPS integration: From the Windows Server 
Control Panel, open System → Advanced System Settings, go to the Advanced 
tab and click Environment Variables.  

a) In the System Variables section, click New and add an environment variable 
ANGOSS_DLL with the value AngossData64-2022.3.dll 

b)  In the System Variables section, select the PATH variable, click Edit, and 
add the path to the KS Server bin folder at the end. For example, if KS 
Server is installed in the default location, this is C:\Program 
Files\Altair Data Analytics\KS Workstation 2022.3.0\bin  

Install and Configure Bitvise SSH Server 

Bitvise SSH server is required for WPS integration for Knowledge Studio in the 
client/server mode. It can be downloaded from https://www.bitvise.com/ssh-server-
download. Install and configure the standard, fully functional Bitvise SSH server edition. 
The detailed configuration instructions are available here: 
https://www.bitvise.com/configuring-ssh-server-for-sftp. Below is a brief description of the 
installation and configuration steps suitable for most cases: 

https://www.bitvise.com/ssh-server
https://www.bitvise.com/ssh-server-download
https://www.bitvise.com/ssh-server-download
https://www.bitvise.com/configuring-ssh-server-for-sftp
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1. Download the file BvSshServer-Inst.exe and run the downloaded executable. In 
the installation wizard, make sure you select the standard, fully functional Bitvise 
SSH server edition that supports domain accounts. 

2. When the installation is complete, the Bitvise SSH Server Easy Settings window 
appears. In the Server Settings tab, select the desired option for “Open 
Windows Firewall”. If you choose any option other than “Open port(s) to any 
computer”, make sure the listening port is accessible to the computers of all KS 
Server users. 

 

Check the settings in the Windows accounts tab and modify them if necessary 
(see the next screenshot). Make sure that logging in to Windows domain 
accounts of KS Server users is allowed. 
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If required, configure access for the Virtual accounts in the third tab. 

3. If you choose not to start the server upon closing the Easy Settings dialog, start it 
from the Bitvise SSH Server Control Panel, as shown below. Easy Settings and 
Advanced Settings are also available in the same Control Panel dialog. For 
detailed description of advanced settings, see 
https://www.bitvise.com/configuring-ssh-server-for-sftp   

https://www.bitvise.com/configuring-ssh-server-for-sftp


 

51 
 © Copyright 2022. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

 

4. Windows Firewall configuration for Bitvise SSH Server: Depending on your 
Windows Firewall configuration and security rules, you may need to edit the 
default Inbound rules for Bitvise SSH Server. In your Windows Server Control 
Panel, open System and Security → Administrative Tools → Windows Firewall 
with Advanced Security 
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5. Expand the top item in the left panel and open Inbound Rules. Double-click the 
rule “Bitvise SSH Server (TCP/IPv6 22)” to open its properties. Go to the Scope 
tab of the Properties dialog and specify the desired Remote IP address range for 
computers allowed to access the SSH server. Make sure the computers of the 
Angoss software users are within this range. 
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6. Go to the Advanced tab of the Properties dialog and specify the desired profiles 
to which the rule applies. Make sure the computers of the KS Server users fit at 
least one of these profiles. 

 

7. Set the same properties for the rule “Bitvise SSH Server (TCP/IPv4 22)”. 

8.2. KS Server Installation and Configuration on Linux 

This section describes the process of installing and configuring KS Server and dependent 
components on Linux. For system requirements and prerequisites, see Section 3 and 
Section 5. Follow the steps below. 

8.2.1. Configure Pluggable Authentication Modules (PAM) for KS Service 

Define the authentication rules for KS Server by creating the KS Service configuration 
file kslogin in /etc/pam.d/. Since these rules should normally be the same as those 

for the standard login service, create kslogin by copying the login configuration file: 

cp /etc/pam.d/login /etc/pam.d/kslogin 

For more information about PAM modules and options, see the system-level 
administration guide in your Linux OS documentation and http://www.linux-pam.org/. 

http://www.linux-pam.org/
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8.2.2. Install KS Server on Linux 

1. Download the KS Server installation package for your Linux system from the 
Altair software download site. For example, for Red Hat enterprise Linux 7, the 
file name is KS-Server-2022.3-rhel7_x64.rpm. Copy the downloaded file to a 
directory on the server. 

2. Log in to the server as root.  

3. If you are upgrading from a previous version of KS Server, note that the installer 
will shut down all current KS Server processes. Notify the users if necessary. To 
check if any KS user processes are running, use the command 

ps -ef | grep kslogin 

4. Run the installer. For example, on Red Hat Enterprise Linux 7, run the command 

rpm -ivh KS-Server-2022.3-rhel7_x64.rpm 

This installs KS Server to /opt/Altair-Data-Analytics and starts the KS 

service kslogin.  

To install to a different directory, specify the desired path after the --prefix 

switch. For example, this command installs KS Server to /apps/Altair-

Data-Analytics on Red Hat Enterprise Linux 7: 

rpm -ivh --prefix=/apps KS-Server-2022.3-rhel7_x64.rpm 

5. Verify that the KS service has started successfully. The following messages 
indicate the successful start: 

/opt/Altair-Data-Analytics/KS-Server-

2022.3/lib/kslogin(service_pid=2951,server_pid=2952) 2018-

12-08 23:33:06 server start: port 5470 

/opt/Altair-Data-Analytics/KS-Server-2022.3/lib/kslogin: 

logging to kslogin.log 

6. The license directory is /opt/Altair-Data-Analytics/license. If KS 

Server will be used with a registration-key license, set Read & Write permissions 
to the license directory for all KS Server users. For the Altair Units license, the 
Read permission is sufficient. 

8.2.3. KS Libraries for R and Python 

This section describes the steps to install and configure R and Python integration 
libraries. 

Install and configure KS Library for R 

If the R integration features are required, make sure that R software is installed 
as described in Section 5.2. 

By default, KS Server for RHEL 7 and CentOS 7 is configured to support R 3.5.0 
– 3.6.3, while KS Server for RHEL 8 and CentOS 8 is configured to support R 4.0 
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and higher. If you require integration with a different version of R on your server, 
please contact Customer Support at dasupport@altair.com to request KS Library 
for your version of R. 

In the examples below, it is assumed that R is installed under /usr/lib64/R. 

1. Edit the KS Server startup script ks_start, whose default location is 
/opt/Altair-Data-Analytics/KS-Server-2022.3. In the R environment 

section, specify the value for the R_HOME environment variable if the R home 

directory on your server is different from the default specified here: 

R_HOME=/usr/lib64/R 

export R_HOME 

2. Uninstall any previous version of KS Library for R as follows:  

R CMD REMOVE angoss 

R CMD REMOVE KnowledgeSurvival 

3. Install KS Library for R: 

cd /opt/Altair-Data-Analytics/KS-Server-2022.3/R 

Rscript angossSetupR.R 

This will create three directories under the R library location 
/usr/lib64/R/library/: 

• angoss 

• KnowledgeSurvival 

• xtable 

If any users need to use a different R library path, copy the directories angoss, 

KnowledgeSurvival, and xtable to the desired R library location. Note that 

the Rserve library must exist in the same R library location (see Section 5.2.3). 

Configure KS Library for Python 

If Python integration features are required, make sure that Python or one of its 
distribution packages has been installed as described in Section 5.3. 

Edit the KS Server startup script ks_start in /opt/Altair-Data-Analytics/KS-

Server-2022.3. In the Python environment section, specify the value for the 

PYTHON_HOME environment variable. It must point to the parent of the bin directory 

with the Python executable. For example, if the Python executable is 
/usr/bin/python, then PYTHON_HOME must be set as follows: 

PYTHON_HOME=/usr 

export PYTHON_HOME 

mailto:dasupport@altair.com
https://cran.r-project.org/web/packages/Rserve/index.html
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8.2.4. Install and Configure Altair Analytics Workbench (WPS Workbench) 

1. Download the installation package for WPS Analytics for Linux (WPS Analytics Linux 
x64 RPM) from the AltairOne website and copy it to the server where KS Server is 
installed. If you don’t have an account at AltairOne.com, please reach out to the 
person managing Altair software licenses at your organization. 

2. Install WPS Analytics for Linux by running the command 

rpm --install <wps-installation-file>.rpm 

The default installation location is /opt/worldprogramming/wps-<version>.  

3. Create a symbolic link /opt/wps pointing to the WPS Analytics root directory. For 

example, if WPS Analytics is installed in /opt/worldprogramming/wps-4, then 

link it as follows: 

ln -s /opt/worldprogramming/wps-4 /opt/wps 

4. Make sure that the OpenSSH server process (sshd) is running. Refer to the Linux 

documentation for the information on the openssh-server and openssh packages and 
starting the sshd daemon. For example, for RHEL 7, see OpenSSH for RHEL 7. 

5. Create the wpsenv.sh shell script for WPS environment in the WPS root directory 

/opt/worldprogramming/wps-<version> and define the following environment 

variables in this script (in this example, KS Server is assumed to be installed in /opt): 

export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/Altair-Data-

Analytics/KS-Server-2022.3/lib 

export ANGOSS_DLL="libAngossData.so" 

For a self-hosted Altair License Server, define the ALTAIR_LICENSE_PATH variable 
(for altair_license_server, substitute the name or IP address of the Altair 

License Server host machine): 

export ALTAIR_LICENSE_PATH=6200@altair_license_server 

For a Managed Altair Units license hosted in the Altair cloud, define ALM_HHWU: 

export ALM_HHWU=true 

8.2.5. Configure KS Service and Security 

This section describes the steps to configure KS service, the firewall for KS Server 
security, set KS service runtime parameters, and configure database connections. KS 
Server must be restarted as described in the next section for any configuration change to 
take effect. 

Configure KS Service 

The KS Server configuration file kslogin.conf defines the runtime parameters of the 
service such as the port number for the KS service to listen on, the log file name and 
location, etc. The default location of the service configuration file is 

/opt/Altair-Data-Analytics/KS-Server-2022.3/lib 

https://altairone.com/Marketplace?tags=5f0e306ea536a11655834710&app=Altair+Analytics+Workbench&tab=Info
https://access.redhat.com/documentation/en-us/red_hat_enterprise_linux/7/html/system_administrators_guide/ch-openssh
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Example configuration file kslogin.conf: 

port 5470 

backlog 10 

log kslogin.log 

ssl_cert   ssl_cert.pem 

ssl_key    ssl_key.pem 

• The default port number for KS service is 5470. The port number is defined 
by the port parameter. Specify a different port if necessary. 

• The backlog parameter is related to the socket configuration. It defines the 
maximum length that the queue of pending connections may grow to. The 
default value (10) is suitable in most cases.  

• The log parameter defines the name of the KS service authentication log 
file. When its name is specified without the full path, it is located in 
<install_dir>/Altair-Data-Analytics/KS-Server-2022.3. To 

keep the log in a different location, specify the full path, for example: 
/opt/Altair-Data-Analytics/logs/kslogin.auth.log 

• The ssl_options parameter determines the cryptographic protocol to be 
used by KS Server. TLS1.2 is used by default. If desired, configure KS 
Server to use a different version such as TLS 1.1 by setting 

ssl_options tls1.1 

Deprecated protocol versions TLS1.0, SSLv3 and SSLv2 are never used. 

• The ssl_cert and ssl_key parameters name the files containing the SSL 
certificate and key, respectively. Their default values are ssl_cert.pem and 
ssl_key.pem, and the designated location for these files is the KS Server lib 
directory, which also contains kslogin.conf. These files must exist, and the 
OpenSSL library must approve of them, otherwise any connection attempt 
will fail. If necessary, generate your own certificate/key pair and copy it to 
the KS Server lib directory. An example command to generate the SSL 
certificate and key: 

openssl req -x509 -nodes -days 10000 -subj '/' -newkey 

rsa:2048 -keyout ssl_key.pem -out ssl_cert.pem 

• The authenticator parameter defines the authentication mechanism. The 
default authenticator is PAM. If you are using other authentication methods 
where users do not necessarily have entries in /etc/passwd, specify an 

alternative authentication mechanism, for example: 

authenticator pw 

For setting optional advanced runtime parameters, see Chapter 12. 
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Configure Firewall for TCP Port Connections 

Create inbound rules in the Linux firewall for the TCP ports used by KS Server. 
Inbound connections to the KS Server host must be allowed on these ports from the 
KS Workstation client machines. 

• For Knowledge Studio or Knowledge Seeker, open the port specified in 
kslogin.conf (the default is 5470) 

• For Knowledge Studio for Apache Spark, open the port specified in 
kslogin.conf (the default is 5470) and the port range 6060–6090. Ensure the 
network connectivity between the KS Server host and the Apache Spark 
Server. 

8.2.6. Environment for Database Connectivity 

This step is necessary only if the users need to import data from databases. See 
Section 5.5 for prerequisites. 

1. Install the ODBC drivers for the required databases. Native ODBC drivers are 
recommended. For example, for Apache Hadoop, use the Hortonworks or 
Cloudera ODBC drivers available for free from the respective vendors. 

2. Edit the file ks_odbc in the KS Server home directory to set the ODBC 
environment if necessary. The example below assumes that your unixODBC 
libraries are in /usr/lib64 and odbc.ini is in /etc. If you do not define 

ODBCINI and ODBCSYSINI in ks_odbc, the unixODBC defaults will be used. 

export ODBCINI=/etc/odbc.ini 

export ODBCSYSINI=/etc 

export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib64 

3. You may need to add other environment variables depending on the 
requirements for the ODBC driver and the source databases. Please refer to the 
ODBC driver documentation. For example, for the Cloudera native ODBC driver 
for Apache Hive, define the CLOUDERAHIVEINI variable. 

4. Edit the odbc.ini file of unixODBC to configure the Data Source Names (DSN) 
for the desired databases. You may need the help of the database administrator 
to get the host name for the database server, the database name, port number, 
or other connection parameters. An example odbc.ini is provided below. For the 
detailed guide to configuring odbc.ini for data access, refer to 
http://www.unixodbc.org/ and your ODBC driver documentation. 

DSN Configuration Example: 

The following odbc.ini example file defines Data Source Names (DSN) for 
Teradata, Oracle, MySQL, SQL Server, and Apache Hive databases.  

[ODBC Data Sources] 

TeradataDB=Teradata ODBC Driver 

OracleDB=Oracle Native ODBC driver 

SQL_Server=Microsoft ODBC Driver 13 for SQL Server 

http://www.unixodbc.org/


 

59 
 © Copyright 2022. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

MySQL=MyODBC 5.3.10 Driver DSN 

HortonWorksHive64=Hortonworks Hive ODBC Driver 64-bit 

 

[ODBC] 

# Specify any global ODBC config here such as ODBC tracing. 

 

[TeradataDB] 

Driver = /opt/teradata/client/ODBC_64/lib/tdataodbc_sb64.so 

DBCName = tddb.us.cloudapp.azure.com 

 

[OracleDB] 

Driver = /usr/lib/oracle/12.2/client64/lib/libsqora.so.12.1 

ServerName = db_server_name 

Database   = SAMPLE 

SID        = orcldb.company.com 

 

[SQL_Server_1] 

Description=Microsoft ODBC Driver 13 for SQL Server 

Driver=/opt/microsoft/msodbcsql/lib64/libmsodbcsql-

13.1.so.9.2 

Database=sample_db 

Server=db_server_name,1433 

UID= 

PWD= 

 

[MySQL] 

Driver       = /usr/lib64/libmyodbc5a.so 

Description  = Connector/ODBC 5.3.10 Driver DSN 

SERVER       = mysqldb_server_name 

PORT         = 3306 

USER         = dbuser1 

Password     = 

Database     = db_name 

OPTION       = 3 

SOCKET       = 

 

[HortonworksHive64] 

Description=Hortonworks Hive ODBC Driver (64-bit) DSN 

Driver=/usr/lib/hive/lib/native/Linux-amd64-

64/libhortonworkshiveodbc64.so 

HOST=hdp_server_name 

PORT=10000 

Schema=default 

ServiceDiscoveryMode=0 

ZKNamespace= 

HiveServerType=2 

AuthMech=2 

ThriftTransport=1 

UseNativeQuery=0 

UID= 

KrbHostFQDN=_HOST 
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KrbServiceName=hive 

KrbRealm= 

SSL=0 

TwoWaySSL=0 

ClientCert= 

ClientPrivateKey= 

ClientPrivateKeyPassword= 

8.2.7. Starting and Stopping KS Service 

The KS service kslogin starts automatically upon the KS Server installation and listens 
to KS client connections. This section describes the use of KS Server scripts for starting 
and stopping the KS service. 

Starting KS service using ks_start: 

1. Log in as root. 

2. Change to the KS Server home directory. For example: 

cd /opt/Altair-Data-Analytics/KS-Server-2022.3 

3. Run ks_start: 

./ks_start 

The following messages confirm that the KS service started successfully: 

/opt/Altair-Data-Analytics/KS-Server-

2022.3/lib/kslogin(service_pid=2951,server_pid=2952) 2018-

12-08 23:33:06 server start: port 5470 

/opt/Altair-Data-Analytics/KS-Server-2022.3/lib/kslogin: 

logging to kslogin.log  

The service is now ready to accept connections from KS Workstation clients. 
You will be able to test the client/server connection and install the license after 
deploying KS Workstation on Windows (see Section 8.3).  

If any errors are reported, see Section 8.2.8, “Troubleshooting”. 

Stopping the service using ks_shutdown: 

To stop the KS service and all KS users’ kslogin processes on the server, use the 
ks_shutdown command in the KS Server home directory: 

cd /opt/Altair-Data-Analytics/KS-Server-2022.3 

./ks_shutdown 

To restart the KS service, use ks_shutdown first and then run ks_start. 

To stop only a particular user’s process rather than the entire KS service, list all 
kslogin processes first, then kill the process running under this specific user ID: 

ps -ef | grep kslogin 
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get the process ID of the user 

kill -9 <process ID> 

8.2.8. Automating KS Server Startup with Linux Service Management Tools 

This section describes how to make the KS Server service start automatically at boot 
time and use service management commands to start and stop KS Server.   

KS service can be managed using systemd and systemctl. The examples below 
assume that KS Server is installed in the default location under /opt. 

1. Make sure that KS service can be started successfully using ks_start as 

described in the preceding section. 

2. Copy the file ks.service from the KS Server home directory to 

/etc/systemd/system 

cd /opt/Altair-Data-Analytics/KS-Server-2022.3 

cp ks.service /etc/systemd/system 

3. Create a symbolic link "KS-Server" to the KS-Server-2022.3.0 directory in the 

Altair-Data-Analytics directory: 

cd /opt/Altair-Data-Analytics 

ln -s KS-Server-2022.3.0 KS-Server 

4. Enable the ks service by running the command:  

systemctl enable ks 

This will make KS Server start at boot time. 

• To start KS Service, run the command 

systemctl start ks 

• To stop KS Service at any time, run the command  

systemctl stop ks 

• To check if KS Server is running, run the command  

ps -ef | grep kslogin 

For more information on systemd and systemctl, see your Linux System 

Administrator documentation. For example, https://access.redhat.com/articles/754933. 

https://access.redhat.com/articles/754933
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8.2.7. Troubleshooting 

Errors at service startup 

If starting the KS Server service results in error messages, this may indicate that the 
environment is not set properly, or the system is not at the sufficient maintenance level, 
and certain patches need to be installed. 

Connectivity issues 

▪ Connection loss: If an end user working in client/server mode with server on 
Linux gets an exception resulting in the loss of connection with the server, in most 
cases, the problem is resolved on the client side by simply reconnecting to the 
server using the command File | Connect from the application menu. The KS 
Server service on the Linux server does not need to be restarted. 

If you have to restart KS Service, notify the users that it is about to be shut down. 
Then shut down and start KS Service using any of the ways described in Sections 
8.2.5 and 8.2.6. 

▪ Authentication issues: If users get the error message "Authentication failure" or 
similar errors when trying to connect, the most likely cause is incorrect settings in 
the configuration file kslogin.conf. Verify that the parameters in kslogin.conf are 
set properly according to Section 8.2.4, depending on your operating system. 

▪ Failure to connect: If a user gets the error, "No connection could be made 
because the target machine actively refused it", there are two possible causes:  

a) KS service is not running 

b) The user specified the wrong port number or host name when connecting to 
KS Server 

To fix this problem, make sure the kslogin service is running on the server using 
the command ps -ef | grep kslogin. The process "kslogin kslogin.conf" 

owned by root must be running. 

Make sure the user specifies the correct port number and host name in the 
connection dialog. The port number must be the one indicated in the kslogin.conf 
configuration file. 

▪ Abnormal termination of the client/server connection: If the network 
connection between the client machine and the server is lost, the corresponding 
KS server process on the server (KSWinLogin.exe) is automatically terminated 
several minutes after the connection loss. 

Testing the ODBC Connection  

After installing KS Workstation (Section 8.3) and activating the license, test the 
database connectivity as follows. 

1. Run KS Workstation 2022.3 on a Windows client machine and connect to KS 
Server. If necessary, use the Connect command from the File menu and 
specify the KS connection information. 
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2. When connected, install the license if it is not already installed. See Chapter 14 
of this document for the license installation instructions. 

3. Create a new project by selecting Create Project from the File menu.  

4. Right-click anywhere on the Workflow Canvas and select Connect → ODBC 
Import from the context menu. The ODBC Import Wizard will open. 

5. In the ODBC Connection page (see the screenshot below), select the DSN 
option, select the DSN you configured, specify the database user ID and 
password and click Next >. 

NOTE: If you are connecting to DB2, the very first connection must be 
performed with the user ID that has sufficient privileges to create packages. 
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If your DSN is not in the list, this means it is not in the [ODBC Data Sources] 

section of odbc.ini, or the ODBC environment was not configured correctly. 

6. Click Next. The list of your database tables will be displayed in the next page of 
the wizard. Select a table and import data from it. 

If you fail to connect to the database or import any table, check your DSN 
parameters in odbc.ini or consult with your database administrator. 

Troubleshooting Database Connectivity Issues:  

o If no tables are displayed after connecting to a database, check the 
UseCurrentSchema parameter (if available) in the DSN description for 
your database in odbc.ini. If UseCurrentSchema=1, the database driver 
looks for tables only in the default schema (the schema with the same 
name as the database user name specified in the wizard). Change it to 
UseCurrentSchema=0 so that the driver could look for tables in all 
accessible schemas and try connecting again. 

License Errors 

o If you are using an Altair Units license for KS Server on Linux and are 
getting an error message that textrel_shlib_t failed to run, make 

sure there is an exec permission on the /tmp partition. Remount the /tmp 
partition to run exec as follows: 

mount -o remount,exec /tmp 

System Configuration for Large File Support 

 
Some operations in KS Server, such as importing a large file, may take a lot of memory. It 
may be necessary to adjust the resource limits of your operating system. 

Edit the file /etc/security/limits.conf to view or set the desired ulimit values to 

increase file size limits and process memory size limit if necessary. See the manual 
pages for ulimit and your Linux System Administrator documentation for details. 

8.3. Deploying KS Workstation and Dependent Components for Client/Server 
Configuration 

This section describes the interactive installation of KS Workstation (desktop client) and 
dependent components on the client machines as part of the deployment procedure for the 
client/server configuration. It is assumed that KS Server is already installed on the server. 
For non-interactive installation modes such as silent install, see Section 9. 

8.3.1. Installing KS Workstation 

1. Log in to the client machine as a user with sufficient rights to install software. 

2. Double-click the downloaded MSI package KS-Workstation-2022.3-64bit.msi. 

3. The setup prepares the InstallShield Wizard, and the Welcome window opens. 
Click Next >. 
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4. The License Agreement window opens. If you accept the terms, select “I accept” 
and click Next > 

 

5. The Configuration Type window opens. Select the Client/Server configuration 
option and click Next >. 
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6. Make sure all features are selected. If necessary, change the destination folder 
for the application program files on the client machine by clicking the Change 
button and specifying the desired location. The default is C:\Program Files\Altair 
Data Analytics. Click Next >. 

 

7. The KS Server Connection Properties window opens. 
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▪ In the Host field, enter the name or the IP address of the server where KS 
Server is installed. 

▪ In the Port field, enter the port number to be used by the client to connect to 
KS Server. The default port number is 5470. If you change it, make sure it is 
the same as the one specified in the KS Server configuration (see Section 
8.1.4. “Configuring the KS Service”). 

▪ In the Working Directory field, enter the working directory for the users’ 
project files. 

Note 1: This directory path must be a local path with respect to the server 
(for example, E:\Altair KS Projects\ for Windows Server, or /apps/ks_projects/ 
for Linux). You can use a network path such as \\server1\ks_projects if the 
Working directory is on a network drive. The Working Directory must have 
Read & Write permissions for the intended users.  

Note 2: The end users can change their Working Directories at any time after 
the installation using the Set Working Directory command in the File menu. 
For example, if you created subdirectories user1, user2, … userN under 
E:\Altair KSProjects, instruct the users to set their Working Directories to the 
respective folders E:\Altair KS Projects\userN.  

 

Click Next >. 

8. At the final step, choose whether to install a desktop shortcut for KS Workstation. 
Click Install to start the installation. 
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9. The Setup Status window opens. It shows the installation progress. When the 
installation is complete, click Finish.   

 

10. The installed software is now available in the program group Start | Programs | 
Altair Data Analytics. 

To activate the product, follow the instructions in Chapter 14: “License 
Administration”. 
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8.3.2. Installing Altair Analytics Workbench (WPS Workbench) 

1. Download the 64-bit version of Altair Analytics Workbench from the AltairOne website. 
If you don’t have an account at AltairOne.com, please reach out to the person 
managing Altair software licenses at your organization. 

2. Run the downloaded installation package. Click Next > in the Welcome screen.  

 

3. In the End-User License Agreement window, select “I accept the terms in the 
License Agreement” if you accept the terms. Click Next >. 

https://altairone.com/Marketplace?tags=5f0e306ea536a11655834710&app=Altair+Analytics+Workbench&tab=Info
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4. In the Custom Setup page, select all WPS program features, as shown below. To 
change the destination folder for the application program files, click the Change button 
and specify the desired location. The default is C:\Program Files\World 

Programming\WPS Analytics\4. Click Next >. 

 

5. Click Install to start the installation. 
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6. The Setup Status window shows the installation progress. When the installation is 
complete, click Finish. 

 

7. When the installation has finished, the new folder WPS Analytics with the item WPS 
Workbench appears in the programs list of the Windows Start menu, and the WPS 
Workbench shortcut is created on the desktop.  

8. Apply your license on the client machine as described in Section 14.2. Configuring 
Altair Units Licensing. 
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9. Alternative Installation Modes on Windows 

9.1. Silent Install 

To install KS Workstation in the silent mode from the command line without user 
interaction, follow these steps: 

1. Copy the downloaded installation package KS-Workstation-2022.3-64bit.msi to a folder 
on the intended host machine. 

2. Run Command Prompt as administrator. For example, on Windows 10, select Start | 
Windows System, right-click on Command Prompt, and select More → Run as 
administrator. 

3. Type msiexec.exe in the command prompt and press Enter. The Windows Installer 
window displays its version and usage options. The syntax of the commands depends 
on the version of Windows Installer on your system. For more information, see the 
Windows Installer Portal and the information on the Command Line Options.  

4. The following examples show how to install KS Workstation in several typical cases.   

• NEW INSTALLATION: To install KS Workstation 2022.3 with default settings to the 
default destination folder C:\Program Files\Altair Data Analytics 

and save the installation log in the file ks_install.log, execute the following 
command as a single line: 

msiexec.exe /package "C:\temp\KS-Workstation-2022.3-

64bit.msi" /quiet /log ks_install.log 

• UPGRADE: To install KS Workstation 2022.3 and apply the preferences of the 
previous version, specify the preferences file of the previous version as an 
argument in the silent install command line. For example: 

msiexec /i "KS-Workstation-2022.3-64bit.msi" /l*v 

"install.log" CWDGROUP="C:\Work\Altair KS Projects" 

PREFERENCES="C:\Users\jsmith\AppData\Roaming\Altair\KSMainNe

t64-2022.0.xml" /quiet 

As a result, all applicable parameters in the specified XML file that correspond to 
the preference values will be set as the default preference settings in Tools | 
Preferences of the installed application. Note that the Working Directory is 
specified separately using the options CWDGROUP or SCWD (see the table 
below). 

• UNINSTALL: To uninstall KS Workstation 2022.3, use the following command as a 
single line: 

msiexec.exe /uninstall "C:\temp\KS-Workstation-2022.3-

64bit.msi" /quiet /log ks_install.log 

The complete list of options that can be specified to customize the installation is given 
below. The values must be specified in double quotes, except ALMSERVER. Examples 
are given below. 

https://docs.microsoft.com/en-us/windows/win32/msi/windows-installer-portal
https://docs.microsoft.com/en-us/windows/win32/msi/command-line-options
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LICENSEDIR 

License directory location. The default is 
%APPDATA%\Altair\license.  Note: this is only applicable to 

the standalone configuration using Registration-Key Licensing. It 
is ignored by the application in the client/server mode. 

ALMSERVER 
Altair License Server to be contacted for Altair License Units. 
Example: ALMSERVER=6200@alm_server_name 

PREFERENCES 
The preferences file that contains the application preferences to 
be applied. Example syntax:  
PREFERENCES="C:\TEMP\KSMainNet64-2021.1.xml" 

CWDGROUP 

Working Directory location in the Standalone mode. The default is 
the “Altair” folder under the current user’s My Documents folder. 
Not applicable to the client/server mode. When deploying the 
client for the client/server configuration (KSSERVERTYPE=2) use 
the keyword SCWD to set the Working Directory on the server. 

SCWD 
The Working Directory location on the server (in the case of the 
client/server configuration). This is used in combination with 
KSSERVERTYPE=2 (see below).  

INSTALLDIR 
Installation directory. The default is “C:\Program 

Files\Altair Data Analytics” 

KSREGKEY Registration Key (applicable for Registration-Key Licensing only). 

DSKTOPSTCUT Desktop shortcut option (“1” if required to create; “0” otherwise) 

PDFPRINTER 
Install Amyuni PDF Printer. (“1” if required to install; “0” 
otherwise). The printer driver is required for users to be able to 
save trees, tables, charts, and reports as PDF. The default is “1”. 

KSSERVERTYPE 

Determines whether the mode is Standalone or Client/Server. 

“1” -  the standalone mode. This is the default option. 

“2” -  the client/server mode (KS Workstation serves as a client to 
connect to KS Server) 

KSHOSTNAME 
The name of the KS Server host to connect to. (Applicable to the 
client/server configuration, when KSSERVERTYPE=”2”) 

KSPORT 

The TCP port number for the KS Workstation (client) to connect 
to KS Server. The default is “5470”. 

Applicable only to the client/server configuration, when 
KSSERVERTYPE=”2” and KSHOSTNAME is specified. 
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Here is an example command (must be specified as a single line in the command prompt 
or script): 

msiexec.exe /package "C:\Temp\KS-Workstation-2022.3-64bit.msi" 

/quiet /log ks_install.log INSTALLDIR="D:\Program Files\Altair 

Data Analytics" 

LICENSEDIR="C:\Users\jsmith\AppData\Roaming\Altair\license" 

ALMSERVER="6200@server1.domain1.com" 

CWDGROUP="C:\Users\jsmith\Documents\Altair" DSKTOPSTCUT="1" 

PDFPRINTER="1" 

If you are performing silent install on multiple PCs at the same time, after the installation 
you can set the default configuration (client/server or standalone mode, server name to 
connect, port number, and default Working Directory) on the client side by replacing an INI 
file in the KS Workstation program folder on every client PC. The configuration file is 
C:\Program Files\Altair Data Analytics\KS Workstation 

2022.3.0\bin\KDSConnection.ini  

For example, if you want KS Workstation to connect by default to a specific server and set 
the working directory to D:\KS_Projects, the contents of KDSConnection.ini should be as 
follows: 

<Config> 

<Mode>1</Mode> 

<Location>D:\KS_Projects</Location> 

<Service></Service> 

<User></User> 

<Host>server_name_or_ip_address</Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

9.2. Customizations to Assist in Repackaging for Deployment 

The KS Workstation installer and software support the capability of deploying on a large 
number of workstations using automated installation tools. This section provides guidelines 
on how to prepare the software for this type of deployment. 

1. Run the installation package file KS-Workstation-2022.3-64bit.msi. 

2. The InstallShield Wizard automatically begins extracting the files needed to install the 
software. When it is ready, the Welcome window opens. Click Next >.  

3. The License Agreement window opens. Read the license agreement carefully. You 
can print the agreement, if necessary, by clicking the Print button. If you don’t accept 
the terms, click Cancel to exit the installation. If you accept the terms, select “I 
accept” and click Next >. 

4. The Customer Information window opens. Enter your User Name and Organization 
information. Click Next >. 

5. The Setup Type window opens. Select the Custom option and click Next >. 
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6. The Custom Setup window opens. 

▪ If your purpose is to deploy the Standalone configuration, proceed as follows:  

6.1. In the Custom Setup window: 

o If necessary, change the destination folder for the program files by 
clicking the Change button and specifying the desired location. The 
default is C:\Program Files\Altair Data Analytics. 

Click Next >.  

6.2. The Destination for KS Workstation Program Files window opens. 

o Make sure the Standalone option is selected.  

o The Working Directory can be parameterized to point to each end user’s 
default folder My Documents\Altair or another folder specific for each 
user. For example, specify the following path in the Working Directory 
field ensuring to maintain the spaces and the case of the letters:  

%USERPROFILE%\Documents\Altair 

Note: Each user will be able to change the Working Directory at any time 
after the installation using the Set Working Directory command in the 
File menu. 

o If necessary, specify the custom location for the license files in the 
License Location field. The default is %APPDATA%\Altair\license. 
Usually it is C:\Users\<user ID>\AppData\Roaming\Altair\license. 

Click Next > and then click Install in the next page to start the installation. 
Proceed to Step 7. 

▪ If your purpose is to deploy the Client/Server configuration, proceed as follows 
(Note: it is assumed that KS Server is already installed on a server):  

6.1. In the Custom Setup window: 

o If necessary, change the destination folder for the program files by 
clicking the Change button and specifying the desired location. The 
default is C:\Program Files\Altair Data Analytics. 

Click Next >. 

6.2. The KS Server Connection Properties window opens. 

o Select the Client/Server option. 

o In the Host field, enter the name or the IP address of the server where 
KS Server is installed. 

o In the Port field, enter the port number to be used by the client to 
connect to KS Server. The default port number is 5470. If you change it, 
make sure the port number entered here is the same as the one 
specified in the KS Server configuration. 

o In the Working Directory field, enter the directory for users’ projects. 
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Note 1: This directory path must be a local path with respect to the 
server machine (for example, C:\UserProjects\ for Windows Server 

or /home/userprojects/ for Linux). You can use a network path such 

as \\server1\projects if the Working directory will be on a server 

different from the one that hosts KS Server. The Working Directory 
should have Write permissions for the intended user(s); 

Note 2: The end users can change their Working Directories at any time 
after the installation by using the Set Working Directory command in 
the File menu. 

If each user is supposed to have a separate working directory on the 
server, the Working Directory entry can be parameterized to point to end 
users’ individual folders (e.g., C:\UserProjects\<user_name>). For 

example, specify the following path ensuring to maintain the spaces and 
the case of the letters: 

C:\UserProjects\%USERNAME% 

o If necessary, specify a location for the license files in the License 
Location field. This must be a local path with respect to the server. The 
default is C:\Program Files\Altair Data Analytics\License. 

Click Next > and then click Install to start the installation. 

7. The Setup Status window opens. It shows the installation progress. When the 
installation is complete, click Finish. 

If the custom settings you programmed during the installation don’t take effect, the 
workaround is to set the custom configuration after deploying the product with default 
settings. You can set the mode (client/server or standalone), server name to connect, port 
number, and the Working Directory by replacing an INI file in the KS Workstation program 
folder on every client PC. The configuration file is C:\Program Files\Altair Data 
Analytics\KS Workstation 2022.3.0\bin\KDSConnection.ini  

For example, if you want KS Workstation to connect by default to a specific server and set 
the working directory to D:\KS_Projects, the contents of KDSConnection.ini should 

be as follows: 

<Config> 

<Mode>1</Mode> 

<Location>D:\KS_Projects</Location> 

<Service></Service> 

<User></User> 

<Host>server_name_or_ip_address</Host> 

<Port>5470</Port> 

<Secure>True</Secure> 

</Config> 

In this case, however, the Working Directory will be the same for all users, and they will 
need to change it using the File | Set Working Directory command if they need separate 
working directories.  
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10. Deploying in Citrix and Remote Desktop Services 

Environments 

10.1. Citrix 

In a Citrix environment, you will need to deploy the Client/Server configuration of the product. 
KS Workstation can be replicated across as many computers of the Citrix farm as desired, 
while KS Server must be installed on a single server, which may be outside of the farm. 

Here are the steps required to deploy the product in a Citrix environment: 

▪ Make sure all the installation prerequisites listed in Section 5 are met. Allocate the 
necessary disk space on the server and create Working Directories for the users 
following the guidelines in Section 5. 

▪ Follow the instructions in Section 8: Deploying Client/Server Configuration. See also 
Section 9 if you plan to package the Workstation for mass deployment on your Citrix 
farm computers.  

Note: The installation wizard for KS Workstation lets you specify a location for the 
Working Directory. The users will still be able to change their Working Directories at 
any time using the File | Set Working Directory menu command (or the File | 
Connect command). If you want the users to use separate working directories 
(recommended) rather than a shared one, you will need to either parameterize the 
Working Directory in the installation wizard as described at the end of Section 9.2, or 
notify the users after you finish the installation that they should set Working Directory 
to the appropriate locations. 

▪ The license is installed after completing the installation of both the server and 
Workstation. This can be done from any KS Workstation application. Proceed to 
Chapter 14, “License Administration”, for the license installation guidelines. 

10.2. Remote Desktop Services 

If you intend to use the product in a multi-user environment where users access the software 
via Windows Remote Desktop Services, you will need to deploy the standalone configuration 
of the product, but you must purchase the server-level license (even if the operating system 
on the host machine is of Windows Workstation type).  

The installation procedures are the same as those described in Section 7, “Deploying 
Standalone Configuration”.  Follow these steps: 

▪ Make sure all the installation prerequisites listed in Section 5 are met.  

▪ Determine whether a separate Working Directory is required for each user or one 
shared Working Directory is required for all users.  

If the users require separate Working Directories, create one for each user and 
assign appropriate read/write permissions for the created directories. After you finish 
the installation, notify the users that they should set Working Directory to the 
appropriate locations. Any user can change his/her working directory at any time after 
the installation by selecting menu commands File | Connect or File | Set Working 
Directory… in the client application.  
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▪ Proceed to Section 7, “Deploying Standalone Configuration”. Follow the instructions 
therein, taking into account the following details:  

o If each user requires a separate Working Directory for their projects 
(recommended in most cases), then  

▪ If necessary, create a new folder for each user of the application. For 
example, create a folder called Altair under the My Documents folder of 
each user profile. Make sure it has read and write permissions for the 
respective users. The Working Directory does not have to be on the 
server that hosts KS Server. It can be a network folder, and users can 
refer to it using a UNC path. Note that KS Server cannot access mapped 
drives in the client/server mode on Windows. 

▪ In the installation wizard, choose the Custom option (see the Custom 
setup option in Step 7 of Section 7). For the Working Directory, specify 
any folder that has Read permissions for all users.  

▪ After the installation and license activation is done, instruct the users to 
run KS Workstation and set their Working Directories to their respective 
working folders for projects using the File | Set Working Directory menu 
command (or File | Connect command) 

o If all users require a single shared Working Directory for their projects, then  

▪ Create a folder with Read and Write permissions for all users. The 
Working Directory does not have to be on the server that hosts KS 
Server. It can be a network folder, and users can refer to it using a UNC 
path. Note that KS Server cannot access mapped drives in the 
client/server mode on Windows. 

▪ Specify this folder as the Working Directory in the installation wizard (see 
the Custom setup option in Step 7 of Section 7). 

▪ Proceed to Chapter 14, “License Administration”, for license installation 
guidelines. 
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12. Advanced Configuration: Optional Runtime Parameters 

Optional runtime parameters for the application can be specified in a special configuration file. 
To set any of the parameters described below, use any text editor to create a new file called 
KDSProvider.conf in the directory that contains the application binaries. The default 

location for the configuration file is: 

• For the standalone configuration of KS Workstation on Windows: 

C:\Program Files\Altair Data Analytics\KS Workstation 2022.3.0\bin 

• For the client/server configuration on Windows Server:  

C:\Program Files\Altair Data Analytics\KS Server 2022.3.0\bin 

• For KS Server on Linux:  

/opt/Altair-Data-Analytics/KS-Server-2022.3/lib 

Since file names on Linux are case-sensitive, make sure that you name the file exactly 
as specified: KDSProvider.conf. 

In the client/server configuration, after modifying KDSProvider.conf, KS Server must be 
restarted for the changes to take effect. 

The following runtime parameters can be specified in KDSProvider.conf:  

• proc – maximum number of threads created by the engine processes (the default is 

“unlimited”). 

• cores – maximum number of CPU cores used (the default is “unlimited”) 

• index_max – maximum size of the temporary index file during data import. 

Determined dynamically by the engine unless the value is set. 0 means “unlimited”. 

• pivot_max – maximum size of the temporary pivot file during data import. 0 means 

“unlimited”. 

• window_max – maximum size of memory window during data import. If the value is 

not set, this does not exceed 3 GB. 0 means “unlimited”. 

• y2k_future – together with y2k_window, defines the default century for Date 

variables. This is ignored if y2k_window has been assigned a value. 

• y2k_window – together with y2k_future, defines the default century for Date 

variables. If no value is assigned, then it is computed from y2k_future as follows: 
y2k_window = current_year + y2k_future - 100 

• wamp.enabled – enables the WAMP service (required for Knowledge Studio for 

Apache Spark) 

• wamp.no_tls1.1 – explicitly disables the use of TLS version 1.1 for WAMP. The 

default value is 1, which means that only TLS 1.2 or higher is used, and TLS 1.1 is 
not used. 

• jupyter_path – full path to the jupyter executable (enclosed in double quotes). 
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Example configuration in KDSProvider.conf:  

jupyter_path ”C:\ProgramData\miniforge3\Scripts\jupyter.exe” 

proc 4 

cores 2 

index_max 0 

pivot_max 0 

window_max 0 

y2k_future 10 

y2k_window 

wamp.enabled 0 

wamp.no_tls1.1 1 

In this example, since index_max, pivot_max, and window_max are set to 0, data 

import operations will use as much memory as available on the host system. Be careful 
with these settings if you must limit the resource usage in multi-user environments. 

After setting or changing any parameters in KDSProvider.conf, restart KS Server in the 
case of the client/server configuration or KS Workstation in the standalone configuration.  

13. Uninstalling Altair Data Analytics Products 

This section describes the procedure of uninstalling, modifying, or repairing the products 
featured in this guide.  

13.1. Modifying, Repairing, and Removing KS Workstation 

To uninstall KS Workstation, repair the installation, or to add or remove components of the 
software, follow the steps below. 

Note: Uninstalling, modifying, or repairing the software will not delete the users’ projects or 
license files. 

In the Programs and Features list in the Windows Control Panel, select KS Workstation 
2022.3.0.  

▪ To uninstall the software, click Remove or Uninstall.  

▪ To change or modify the installation, click the Change button. 

1. The Welcome window opens. Click Next >. 

2. The Program Maintenance window opens. The description beside each explains 
in detail what it does. Select the appropriate radio button and click Next > to 
continue.  

o If you selected Modify, the Custom Setup window opens. A list 
shows you the components that are available, and the 
components that are already installed. See the appropriate 
installation instructions above for the description of the options in 
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this window. Select or deselect the components to install or 
uninstall. Click Next >. 

o The Data Mining Engine Setup Window opens. Change the 
entries as required. See the appropriate installation instructions 
above for the description of the options in this window. Click Next 
> to continue, then click Install.  

o The Setup Status window opens. It shows the installation 
progress. When the maintenance is complete, click Finish. 

OR 

o If you selected Repair, the Ready To Repair the Program window 
opens. Click Install.  

o The Setup Status window opens. The Repair option automatically 
fixes any damaged files or replaces lost files. It begins installing 
the software to the same specifications you selected last time you 
installed. When this process is complete, click Finish. 

OR 

o If you selected Remove, the Remove the Program window 
opens. Clicking the Remove button will uninstall the program. 
When this process is complete, click Finish. 

13.2. Modifying, Repairing, or Removing KS Server for Windows 

To uninstall KS Server, repair or change the installation, follow the steps below. 

Note: Uninstalling, modifying, or repairing the software will not delete the users’ projects or 
license files. 

Open the list of Programs and Features on Windows Server and select KS Server 
2022.3.0. 

▪ To uninstall the software, click Remove or Uninstall. 

▪ If you want to change or modify the software, click the Change button.  

1. The Welcome window opens. Click Next>. 

2. The Program Maintenance window opens. The description beside each 
explains in detail what it does. Select the appropriate radio button and 
click Next>.  

o If you selected Modify, the Custom Setup window opens. A list 
shows you the components that are available, and the 
components that are already installed. See the appropriate 
installation instructions above for the description of the options in 
this window. Select or deselect the components to install or 
uninstall. Click Next>. 

o The Windows Service Setup Window opens. Choose the desired 
options. See the appropriate installation instructions above for the 
description of the options in this window. Click Next> to continue, 
then click Install.  
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o The Setup Status window opens. It shows the installation 
progress. When the maintenance is complete, click Finish. 

OR 

o If you selected Repair, the Ready To Repair the Program window 
opens. Click Install.  

o The Setup Status window opens. The Repair option automatically 
fixes any damaged files or replaces lost files. It begins installing 
the software to the same specifications you selected last time you 
installed. When this process is complete, click Finish. 

OR 

o If you selected Remove, the Remove the Program window 
opens. Clicking the Remove button will uninstall the program. 
When this process is complete, click Finish. 

13.3. Uninstalling KS Server on Linux 

To uninstall KS Server on Linux, follow these steps: 

1. To prevent the interruption of any user’s work by shutting down the service, identify 
the user processes using the command ps –ef | grep kslogin and make 

sure there are no active client sessions.  

2. Shut down the kslogin service and terminate all users’ kslogin processes on the server 
by running the script ks_shutdown from the Altair Data Analytics home directory. 

3. If you used R language integration features on Linux and would like to uninstall the KS 
Library for R and Survival Analysis package, use the commands:  

R CMD REMOVE angoss 

R CMD REMOVE KnowledgeSurvival 

4. If you are planning to reinstall the product or upgrade to a new version, make a 
backup copy of the KS Server licenses. For example, if the product is installed under 
/opt/Altair-Data-Analytics, copy the directory /opt/Altair-Data-Analytics/license/ to a 
backup location. Also, back up the environment and startup scripts and odbc.ini in 
/opt/Altair-Data-Analytics/KS-Server-NN.N, where NN.N is your current version. 

5. Check the KS Server 2022.3 package name using any of the commands  

rpm -qa KS-Server 

rpm -qaiv KS-Server  

The latter provides a detailed description of the package. 

To uninstall KS Server 2022.3, use the command  

 rpm -e <package_name> 

where <package_name> is the exact name reported by the command rpm -q KS-

Server, for example, KS-Server-2022.3-18151_centos7.x86_64. 
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If there are any errors during the uninstall, you may use the command  

rpm -e package_name --noscripts 

After that you can delete the KS Server home directory. For example,  

rm –rf /opt/Altair-Data-Analytics/KS-Server-2022.3.0  

where X.X is the KS-Server version. You can also delete the parent directory 
/opt/Altair-Data-Analytics after backing up the license folder and any configuration 
files, if necessary. 

6. If you enabled the automatic startup of KS Server as described in Section 8.2.9, 
"Enabling automatic startup", delete the startup script and the related link (if any) from 
the corresponding system directories. The location of the startup scripts depends on 
your operating system (refer to Section 8.2.9 for details). 
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14. License Administration 

14.1. Licensing System Overview 

Two licensing systems are supported for Altair Data Analytics applications:  

• Altair Units licensing 

• Registration-key licensing 

The system that your product is using depends on the terms of your contract. 

Altair Units Licensing 

Altair Units is a value-based license management system enabling metered usage of 
an entire suite of products. All Altair Data Analytics products have a capability to use 
a single pool of recyclable Altair Units.  

If you purchased an Altair Data Analytics product with an Altair Units license, you will 
receive a license file and Altair Licensing Quick Installation Guide, which describes 
the installation and configuration of Altair License Manager with the License Server. 

The process of configuring the end users’ machines with Altair Data Analytics 
applications to connect to Altair License Server is described in Section 14.2: 
“Configuring Altair Units Licensing” of the present document. 

Registration-Key Licensing 

Registration keys issued by Altair License Administrator are used by the end users 
to acquire licenses online from the Altair License Fulfillment Server (ALFS) – a 
secure self-service license generation website. 

Licenses are acquired from ALFS using the License Manager command in the Help 
menu of Altair Data Analytics applications. This process is described in Section 14.3 
below. Registration-key licenses can also be acquired by email when network 
access to ALFS is not available. 

14.2. Configuring Altair Units Licensing 

If you purchased an Altair Data Analytics product with an Altair Units license, the 
application must be configured to connect to an Altair License Server. 

The installation of the Altair License Manager software is described in the Altair License 
Quick Installation Guide that you received from Altair together with the license file.  

If you purchased the software with Managed Altair Units, the License Server is hosted by 
Altair in the Altair cloud. In this case you will receive instructions on how to authorize the 
users’ machines for Managed Licenses. 
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This section describes the process of configuring Altair Data Analytics applications to use 
Altair license system in each of the following cases: 

• Connecting to Altair License Server  

• Using Managed Altair Units 

It is assumed that Altair License Server is up and running. 

There are three configurations of Altair Data Analytics applications: 

1. Standalone  

2. Client/Server for Windows Server 

3. Client/Server for Linux 

14.2.1. Environment Variables in the Standalone Configuration 

From the Windows Control Panel, select System and click Advanced System 
Properties.  

 

In the Advanced tab of the System Properties dialog, click the Environment 
Variables button.  
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Click the New button in the System variables section or in the User variables 
section, depending on whether the Altair license server connection is required for all 
users on this machine or only the user ID currently logged in. 

 

• Set Variable name to ALTAIR_LICENSE_PATH  

• For the Variable value field:  

o If you are using Altair License Server, enter its address and port 
number. The format is:  NNNN@<server-name>, where NNNN is 
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the port number (6200 by default), and <server-name> is the Altair 
License Server host name. For example: 6200@server.domain.com 

o If you are using Managed Altair Units, set the value to false 

Click OK to create the variable. 

Click the New button in the same section as ALTAIR_LICENSE_PATH. 

 

• Set Variable name to ALM_HHWU  

• To use Managed Altair Units, set the value of ALM_HHWU to true. 
Otherwise, set it to false.   

Click OK in all dialogs to save the changes and exit the Advanced System 
Properties dialog.  

Start the KS Workstation application.  

The Select Product window will prompt you to select one of the four products: 
Knowledge Seeker, Knowledge Studio, Knowledge Studio for Apache Spark, or 
Knowledge Studio Student Edition.  

 

Select the desired product and click Launch. 
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14.2.2. Environment Variables for KS Server on Windows 

From the Windows Server Control Panel, select System and click Advanced 
System Properties.  

 

In the Advanced tab of the System Properties dialog, click the Environment 
Variables button.  
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Click the New button in the System variables section. 

 

• Set Variable name to ALTAIR_LICENSE_PATH  

• For the Variable value field:  

o If you are using Altair License Server, enter its address and port 
number. The format is NNNN@<server-name>, where NNNN is the 
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port number (6200 by default), and <server-name> is the Altair 
License Server host name. 

o If you are using Managed Altair Units, set the value to false 

Click OK to create the variable. 

Click the New button in the System variables section. 

 

• Set Variable name to ALM_HHWU  

• To use Managed Altair Units, set the value of ALM_HHWU to true. 
Otherwise, set it to false.   

Click OK in all dialogs to save the changes and exit the Advanced System 
Properties dialog. 

Start the KS Workstation application on any client machine. 

Connect to KS Server. The Product Selection window will prompt you to select one 
of the four products: Knowledge Seeker, Knowledge Studio, Knowledge Studio for 
Apache Spark, or Knowledge Studio Student Edition.  

 

Select the desired product and click Launch. 
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14.2.3. Environment Variables for KS Server on Linux 

Define the environment variables ALTAIR_LICENSE_PATH and ALM_HHWU in the 
KS Server startup script ks_start as described below. For information about 
ks_start, see Section 8.2.4: “Configuring KS Server on Linux”  

1. If you are using Altair License Server:  

• Set the value of ALTAIR_LICENSE_PATH to the address of the Altair 
License Server. The format is:  NNNN@<server-name>, where NNNN is 
the port number (6200 by default), and <server-name> is the Altair License 
Server host name. For example: 

export ALTAIR_LICENSE_PATH=6200@server1.domain1.com 

• Set the value of ALM_HHWU to false:  

export ALM_HHWU=false 

2. To use Managed Altair Units: 

• Set the value of ALM_HHWU to true 

export ALM_HHWU=true 

• Set the value of ALTAIR_LICENSE_PATH to false: 

export ALTAIR_LICENSE_PATH=false 

Save the changes in ks_start and restart KS Server using any of the methods 
described in Sections 8.2.5 and 8.2.6.  

Define ALTAIR_LICENSE_PATH the same way in the script ksenv.sh used for 
troubleshooting purposes. This script is in the same directory as ks_start. 

Start KS Workstation on any client machine and connect to KS Server. The Product 
Selection window will prompt you to select one of the three products: Knowledge 
Seeker, Knowledge Studio, or Knowledge Studio for Apache Spark.  
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Select the desired product and click Launch. 

14.2.4. Authorize Machine for Managed Altair Units License 

This section describes how to authorize the application host machine(s) for a 
Managed Altair Units license, where the Altair License Server is hosted in the Altair 
cloud. This step is not required if you are using Altair License Server on premises or 
in a cloud managed by your company. 

Standalone configuration for a single user: 

1. If you have not registered on the AltairOne portal yet, ask a user with Altair 
license admin role at your company to add you as a user at 
https://AltairOne.com. You will receive an email from Altair with a link to 
activate your AltairOne account. Click the activation link in your email and 
register on the AltairOne portal. 

2. Open the file browser and navigate to the folder C:\Program Files\Altair 
Data Analytics\KS Workstation 2022.3.0\security 

 

https://altairone.com/
https://altairone.com/
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3. Double-click on the almutil_gui. The Altair License Utility window opens: 

 

4. Go to the Managed Licensing tab of Altair License Utility window: 

 

5. Specify your AltairOne credentials: your email address and password 
that you used to register at the AltairOne portal. Click Sign In.  

Alternatively, if you are not registered at the AltairOne portal and 
received an authorization code an Altair license admin user at your 
company, click Use Auth Code, specify the authorization code received 
from this user and click Authorize. 

You will get the message: “Successfully authorized this machine with the 
Hosted HWU system”. Click OK.  

https://altairone.com/
https://altairone.com/
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Client/Server configuration or Standalone configuration for multiuser access: 

1. If you have not registered yet on the AltairOne portal, ask a user with Altair 
license admin role at your company to add you as a user at 
https://AltairOne.com. You will receive an email from Altair with a link to 
activate your Altair One account. Click the activation link in your email and 
register on the Altair One portal. 

2. Log on to https://altairone.com/Dashboard. In the Manage Account section 
of the Altair One Dashboard page, click Managed Licenses, as shown 
below. 

 

3. In the left pane, click User Profile: 

 

https://altairone.com/
https://altairone.com/
https://altairone.com/Dashboard
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4. Click Authorized Machines in the User Profile page: 

 

5. In the Authorized Machines page, click Generate Auth Code at the top right 
corner: 

 

6. This will generate an authorization code to authorize a machine for the Altair 
license. Copy the code to the clipboard. Note: The code is valid for 15 
minutes, so you must perform the next 7 steps within 15 minutes of 
generating the code. 

 

7. After copying the code:  

• For the Standalone configuration on Windows: run Command Prompt as 
administrator and change to the folder C:\Program Files\Altair 
Data Analytics\KS Workstation 2022.3.0\security 

• For the Client/Server configuration on Windows: run Command Prompt as 
administrator and change to the folder C:\Program Files\Altair 
Data Analytics\KS Server 2022.3.0\security  

• For the client/server configuration on Linux: Change to 
/usr/local/altair/licensing15.1/bin/or to a directory that 

contains almutil. If you cannot find almutil on your system, please contact 
Altair Customer Support. 
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8. Run the following command as administrator, where NNNN is the 
authorization code generated at the previous step: 

almutil -a1auth -system -code NNNNN 

The almutil tool can also be used to test the connectivity with AltairOne 
servers and configure proxy settings for use with AltairOne. Run almutil 

to view the detailed help information on the usage of the utility. 

9. Once you get the message that the machine was successfully authorized, 
restart the KS Server service (in the client/server configuration) or KS 
Workstation (in the Standalone configuration). 

 

14.3. Registration-Key Licensing 

14.3.1. Altair License Fulfillment Server (ALFS) 

ALFS is a secure self-service website used to acquire licenses and view license usage 
information. A registration key is required to log in to ALFS. Knowledge Studio and 
Knowledge Seeker access ALFS through the License Manager feature available from 
the Help menu. ALFS can also be accessed directly from a Web browser at 
https://license.angoss.com. 

ALFS keeps a copy of all acquired licenses. In the event of a system failure or 
accidental deletion of the license on your computer, the license can be retrieved from 
ALFS and reinstalled. 

14.3.2. Registration Keys 

Licenses based on registration keys are legacy licenses that are not available to new 
customers. A registration key is a string about 30 characters long that provides access 
to licenses at the ALFS portal. 

Registration-Key licenses are user-based node-locked licenses available for both the 
standalone and client/server configurations. A named-user registration-key license will 
only operate on a specific machine for a specific user ID. 

14.3.3. Prerequisites for Installing Registration-Key Licenses 

Administrative rights are not required to install licenses. The end users must have Read 
& Write permissions for the license directory. 

If an IT administrator assists the intended user in activating the license, the 
administrator should log in with the user ID of the intended user. 

The path to the license directory is displayed in the License Manager window, which 
can be accessed from the Help menu. 

Standalone configuration 

Start KS Workstation. The License Manager window opens. Proceed to the next section 
for the License Manager instructions. 

https://license.angoss.com/
https://license.angoss.com/
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Client/Server configuration 

In the client/server configuration, the license resides on the server. Before installing 
the license, make sure that KS Workstation is configured to connect to the server.  

1. Start KS Workstation using the desktop icon or the Altair Data Analytics program 
folder in the Windows Start menu. 

2. You will be prompted for your password to log in to KS Server. Enter your 
password (your Windows or Linux user password, depending on the server OS).   

If you are not prompted for your password:  

• Select the Connect command from the File menu. 

• In the Establish Connection dialog:  

o Set the Mode to Client/Server Login.  

o Enter the server name or IP address and the port number. The 
default port is 5470.  

o Specify the working directory if known; otherwise, leave the field 
blank. When the connection is established, the file browser will 
let you browse the server and select a directory if it was not 
specified correctly. 

o Enter the user ID and password (your Windows or Linux user 
credentials, depending on the server OS). 

Click OK to connect. After the connection has been established, the License 
Manager window will open. The License Manager window can also be accessed 
from the Help menu. 

14.3.4. License Manager for Registration-Key Licenses 

The License Manager window for Registration-Key Licenses has the following functions: 

• Acquire and install licenses using one of three options: online through ALFS, by 
email, or import from file. 

• Remove license(s). 

• View the currently installed licenses on the current machine. 

• View all active licenses on ALFS for the specified registration key.  

Acquire License Online 

To acquire a license online from ALFS, click Acquire License Online. 
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This opens the ALFS website https://license.angoss.com: 

 

Enter your registration key and click Log In. 

https://license.angoss.com/
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This screen indicates the product name associated with the registration key, the 
license term (Date Range), the total number of licenses under this key (Count), 
and the number of remaining licenses (shown on the Get License button). Click 
the Get License button. 



 

100 
 © Copyright 2022. Altair Engineering, Inc. – www.altair.com/knowledge-studio 

 

 

Enter the required information. First name, last name, and email are mandatory. 

Click Submit. 

The next screen displays the license content and prompts you to install the 
license. Click Yes to install the license. If there is no prompt, click the Install 
License(s) button at the bottom-right corner. 
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The newly installed license will be displayed in the lower frame of the License 
Manager dialog. 
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Close the License Manager window. 

Acquire License by Email 

Use this option if the client machine has no access to the ALFS website 
https://license.angoss.com. This option requires an email client. 

Click the button Acquire License by Email.  

 

• Enter your registration key, first name, last name, and email address. 

• Make sure the Type of Activation Request is “Get License”. 

• For concurrent licenses only: Specify the path to the Altair license folder 
on the server. 

• Click Email License Request. The license request will be sent to the email 
address productactivation@datawatch.com. 

• Once the request is received, Altair Customer Support will generate and 
email you the license file along with the license installation instructions. 

Import License from File  

Use this option if you received a license file as attachment in a license email from 
Altair. 

https://license.angoss.com/
mailto:productactivation@angoss.com
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• Open the license file attached to the license email message. It is a text file 
with extension *.lic that can be opened in Notepad or another text editor. 

• Select all contents of the license file and copy it to the clipboard. 

• Click Import License from File. 

• Paste the copied text to the Specify License Content window. Click OK. 

• Close the License Manager 

Removing Licenses 

Licenses can be removed using the Remove Selected button in the License 
Manager. 

A confirmation email will be sent to Customer Support at dasupport@altair.com. 

Note: If you are removing a valid license with the purpose of transferring it to 
another user or to a new machine, please email Customer Support to request the 
release of the license on ALFS.  

• Use the Remove column to select the licenses you want to remove. 

 

• Click the Remove Selected button. 

• The Confirm License Deletion dialog will open. Review the licenses 
selected for removal. 

mailto:dasupport@altair.com
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• Select the option to send a confirmation email to Customer Support if an 
email client is present on the current machine. 

• Click OK to remove the selected licenses. 

• Close the License Manager. 

14.3.5. Viewing Active Licenses on ALFS 

To view the list of all active licenses under a specific registration key, log on to the 
ALFS website https://license.angoss.com using the registration key in question. 

Click the link ‘Active Licenses’ in the Get License window. The Active Licenses list 
shows the user’s name, email, and the date of license acquisition for each license. Click 
View for the desired license to view its contents. Click Download for the desired license 
to download the license file. Downloaded licenses can be applied using the option 
“Import License from File” in the License Manager. See the previous section for 
instructions. 

If you access ALFS from the License Manager window, upon clicking View you will be 
prompted to reinstall the license. Click Yes if you want to reinstall it. 

14.3.6. Changing Users and Machines 

If a license needs to be transferred to another user or if the end user’s computer is 
replaced or reimaged, the current license needs to be retired so that it could be 
acquired by a new user or on a new machine. Please send the license transfer request 
to Customer Support.  

 

https://license.angoss.com/
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14.3.7. Privacy and Security 

The following are the features of the registration-key based license system that protect end 
users’ privacy and security: 

• ALFS uses HTTPS for secure communication between the server and users. 

• The users’ profiles and computer names are not transmitted. Instead, an 
encrypted form of this information is transmitted (i.e., Unique User ID and Unique 
Machine ID). This is on top of the HTTPS encryption. 

• All information sent to ALFS is displayed in the submission form, so it is always 
visible exactly what is and what is not transmitted to Altair. 

• ALFS is only contacted during product activation when using the function 
“Acquire License Online” in the License Manager window. 
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15. Contacting Customer Support 

Altair Customer Support website for Data Analytics products:  

https://www.altair.com/data-analytics-support/  

To report issues with the software or ask questions regarding the product features, please contact 
Customer Support via email or telephone: 

• Telephone: 1-888-715-7391 (toll-free within North America) or 1-416-593-2417 

• Data Analytics Customer Support e-mail: dasupport@altair.com  

We welcome your suggestions on how to make our application easier to use and understand. 
Please send your comments and suggestions to dasupport@altair.com. 

Join our online community of experts and users to share insights, collaborate with colleagues and 
find more ways to take full advantage of your product: https://altair.com/knowledge-studio-user-
group 

 

 

https://www.altair.com/data-analytics-support/
mailto:dasupport@altair.com
mailto:dasupport@altair.com
https://altair.com/knowledge-studio-user-group
https://altair.com/knowledge-studio-user-group
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About Altair | Altair Data Analytics 

Altair is a global leader in delivering advanced 
analytics to businesses looking to improve 
performance across risk, marketing and sales. 

Altair removes the complexity inherent with 
predictive analytics and machine learning with 
a platform that is intuitive to use and rich in 
features. It is designed so that Data Scientists 
and Data Citizens alike can build models used 
to help solve business problems. 

https://www.altair.com/  
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